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1. Introduction

About the Manual

This manual provides detailed information on a customized methodology for glacier mapping using a remote sensing 
based semi-automatic technique for quick delivery. Based on this methodology, studies on the status of the glaciers 
of the Hindu Kush Himalaya and decadal glacier change since the 1980s have been carried out in selected areas 
and basins. The data and results derived from this methodology have been published in several journals, book 
chapters, and reports. A summary of the results and publications is presented here, and in global level glacier 
mapping initiatives. Reviews of the methodologies adopted by global initiatives like World Glacier Monitoring 
Service (WGMS), Global Land Ice Measurement from Space (GLIMS), and GlobGlacier are also presented in 
this manual. The methodology can be applied with little knowledge of remote sensing and geographic information 
systems. This is true not only for glacier mapping, but also for mapping the earth’s physical features. 

The methodology relies on the “eCognition” software, and post processing database management is done in 
an ArcGIS environment. A short introductory tour of the software is included here to facilitate the beginner’s 
understanding of image processing and data handling.

We recommend that users read the manual carefully before moving on to hands-on exercises. Prepare the data in 
hand and proceed to semi-automatic mapping for the quick mapping and monitoring of glaciers.

Practice data for this manual are available at this link:
http://www.icimod.org/glacierdata/glacier_training_data.zip

				    Samjwal Ratna Bajracharya
				    Sudan Bikash Maharjan
				    Finu Shrestha
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1. Introduction

Glaciers are solid fresh water reservoirs – lifelines for billions of people in the world. Glaciers in the Hindu Kush 
Himalaya (HKH) are important to global climate change studies, and impact biodiversity, agriculture, industry, and 
economic activities. Glaciers are one of the most sensitive indicators of global temperature change. Climate change 
is vivid and prominent, particularly in high mountains where warming has been much greater, 0.6°C per decade, 
than the global average of 0.74°C over the last 100 years (Shrestha et al., 1999, IPCC 2007, Bajracharya et 
al., 2007). Receding glaciers are an impact of rising temperature. These water reserves are rapidly dwindling. 
Settlements totally dependent on glacier melt are being abandoned. This threatens policies and actions that support 
sustainable water resources management. The bigger concern is a lack of long term information on the glaciers 
of the HKH for any kind of credible assessment. The International Centre for Integrated Mountain Development 
(ICIMOD) has been engaging with partner institutes in the region to build a glacier database of the HKH since late 
1990s. 

Though satellite images have been available since the 1970s, at the time, they were very costly. Even computers 
and software were expensive then. Hence, till the beginning of the 21st century, the mapping of glaciers and glacial 
lakes was mostly done through topographic maps with were manually digitized, consuming both time and resources. 
Using its resources and partners, ICIMOD mapped the glaciers and glacial lakes of the HKH from the topographic 
maps for Nepal, Bhutan, Pakistan, and selected basins in India, and China, from 1999 to 2004. It succeeded in 
mapping only half of the HKH then. The mapping of glaciers and glacial lakes from topographic maps stopped in 
2004. 

Glacier mapping from topographic maps was not only laborious work, it also presented limitations and resulted in 
errors in the database. The errors encountered in glacier and glacial lake databases include: 

1.	 The projection parametres provided in the published topographic maps were incomplete, hence the data derived 
from topographic maps overlaid on Google Earth show some shifting and rotation. 

2.	 The topographic maps of the HKH were mostly published from 1963 to 1982 on the basis of 1,957–1,959 
aerial photographs. Topographic maps were published one/one – with one degree latitude and longitude 
extensions after the completion of survey. Furthermore, field surveys in the high Himalaya were limited, and hence 
not accurate. 

3.	 Due to disputed country boundaries in the HKH, most topographic maps around these territories are restricted, 
and not available for public use.

4.	 The original eight-coloured 1inch to1mile topographic maps of all glaciated area are unavailable. Instead, sheets 
of ammonia print enlarged to a 1:50,000 scale are used. Such maps feature a lot of distortion which amplifies 
errors. 

5.	 Photographs were mostly acquired during winter season. Most glaciated areas are snow covered, and it is 
difficult to differenciate glacier boundaries. Midland and low elevation topographic maps are more accurate 
than maps of snow covered Himalayan areas.

6.	 Satellite images from 1999 and 2000 were also used in some areas where topographic maps were 
unavailable. Thus, the data show a wide temporal range from 1963 to 2000, and are not useful in change 
assessments.

7.	 Human error affected the digitization of glacier and glacial lake polygons since many hands were used, 
depending on the load of glaicer and glacial lake digitization.

To get rid of all these errors, a semi-automatic delineation of glacier and glacial lake polygons were developed 
from Landsat satellite images. With this methodology, the glacier and glacial lake polygons derived from satellite 
image are properly fit onto Google Earth while being overlaid for validation. In 2011, ICIMOD published the first 
comprehensive inventory of glaciers for the entire HKH using a semi-automatic method based on Landsat7 ETM+ 
images from the years 2002 to 2008 (Bajracharya et al., 2011). This is the first report with details of glaciers of 
the entire HKH, including Myanmar. Based on the same methodology, four decades of glacier data from Nepal, 
Bhutan, and selected basins in other countries were also published (Bajracharya et al., 2014 a, b).

1. Introduction
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1.1	 Objective
The objective of this manual is to provide an understanding of remote sensing tools and techniques for the semi-
automatic delineation of clean ice and debris covered glaciers. An automatic method is used to delineate clean ice 
and debris covered glaciers separately from Landsat satellite images. Expert knowledge is used in editing the glacier 
outline for high accuracy. The methodology is efficient, and the glacier polygons derived are of short temporal 
range, and homogeneous. More specifically, this hands-on training manual aims to:

zz Discuss remote sensing tools and techniques which can be used to carry out homogeneous and efficient mapping 
and monitoring of glaciers.

zz Provide a description of mapping guidelines based on WGI (World Glacier Inventory), Global Land Ice 
Measurement from Space (GLIMS), and GlobGlacier consortium.

zz Provide hands-on exercises for practising the semi-automatic delineation of clean ice and debris covered glaciers 
separately. 

zz Develop glacier boundary with high accuracy. 

1.2	 Users
The targeted users of this manual are professionals and researchers working in the HKH who are engaged in glacier 
mapping and monitoring for water resources management, modeling of snow and glacier melt, and climate change 
scenarios.

1.3	 Expected Outcomes
With the use of this training manual, users will become familiar with remote sensing and geographic information 
system tools and techniques for mapping and monitoring, particularly in relation to glaciers and glacial lakes. It will 
also help foster better understanding of the status of glaciers in ICIMOD member countries, and facilitate joint actions 
and plans for a remote sensing based monitoring of glaciers in the region.



3

2. Review of Glacier Inventory

2.1	 Glacier Inventory Initiatives

Global Level 
A worldwide collection of information about ongoing glacier change was initiated in 1894 with the founding of the 
International Glacier Commission at the Sixth International Geological Congress in Zurich, Switzerland. Since then 
a valuable and increasingly important database on glacier change has been built up. In 1986 the World Glacier 
Monitoring Service (WGMS) began collecting and maintaining information on ongoing glacier change when two 
former International Commission on Snow and Ice (ICSI) services—the PSFG (Permanent Service on Fluctuations 
of Glaciers) and TTS/WGI (Temporal Technical Secretary/World Glacier Inventory)—were combined. Today, the 
WGMS (http://www.geo.uzh.ch/wgms/) collects standardized observations on changes in mass, volume, area 
and length of glaciers with time (glacier fluctuations), as well as statistical information on the distribution of perennial 
surface ice in space (glacier inventories).

The Global Land Ice Measurements from Space (GLIMS, http://www.glims.org/) is designed to monitor the world’s 
glaciers primarily using data from optical satellite instruments, such as Advanced Spaceborne Thermal Emission and 
Reflection Radiometre (ASTER). Over 60 institutions across the globe are involved in GLIMS and ICIMOD serves as a 
regional coordinator for Bhutan, India, and Nepal. 

Glaciers are monitored in a variety of manners, such as in-situ mass balance measurements, and air- and space 
borne imaging systems, such as the primary data source used by GLIMS, the ASTER instrument on the Terra 
spacecraft. Results from analysis conducted by the regional centers are sent for archiving at the National Snow and 
Ice Data Center (NSIDC, http://nsidc.org/) and made publicly available.

The GlobGlacier (http://globglacier.ch/) supported by European Space Agency (ESA) is yet another initiative 
to complement and strengthen the existing network for global glacier monitoring. The project will help to establish 
a global picture of glaciers and ice caps, and their role as essential climate variables (ECVs). In this respect, it is 
imperative to complete the world glacier inventory (WGI) from the 1970s by producing glacier outlines in regions 
that haven’t yet been mapped and to complement the point information already stored in the WGI in 2D information 
to allow change assessment. Moreover, GlobGlacier will integrate satellite data from various sensors to create 
value-added products for a wide range of user communities. A close cooperation with major user groups (e.g., 
WGMS) and related projects (e.g., GLIMS) will ensure a maximum benefit of the generated products from a global 
perspective.

Regional Level 
That Himalayan glaciers are sensitive to climate and receding rapidly in area and volume with irreversible long term 
consequences on population and environment is well established. However, a lack of regional coordination for long 
term regular mapping and monitoring hampers further progress on glacial research. Apart from ICIMOD’s initiative to 
map all the glaciers and glacial lakes of the HKH, the Geological Survey of India (GSI) and Cold and Arid Region 
Environmental and Engineering Research Institute (CAREERI) of Chinese Academy of Science (CAS) are also turning 
their focus to glaciology. GSI has conducted advanced studies such glacier mass balance and flow hydrometry of 
Indian glaciers since 1978 (http://www.portal.gsi.gov.in). Similarly, the first national glacier inventory of China was 
carried out in 1979 for the World Glacier Inventory (WGI) and completed in 2002. A second national inventory 
on glaciers in China was completed in 2015 (Guo et al., 2015). Meanwhile, partner organizations in ICIMOD’s 
eight regional member countries are developing their capacity to map glaciers by using a glacier inventory exercise 
provided by ICIMOD. 

In view of the regional need to generate more data and knowledge on the cryosphere, glacial research is important 
not only for water resources and hazard management but also for global climate change research.

2.	Review of Glacier Inventory
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2.2	 Glacier Inventory Approach

WGMS 
In 1970, UNESCO first introduced a classification scheme for perennial snow and ice masses. They aimed to 
provide a useful database of glacial observations in a standardized digital form. The system was designed to 
characterize the morphology of glaciers rapidly and precisely. The major advantage of this system was that it 
allowed the assignment of six characteristics to a glacier. By applying a matrix-type classification based on specific 
glaciological characteristics, this work provides a defined number of values for each parametre. Since then, the 
World Glacier Monitoring Service (WGMS; http://www.geo.unizh.ch/wgms/) had adopted this system in a 
revised form, and applied it to 67,000 glaciers worldwide, of which most are terrestrial. Along with further relevant 
glacier data, the information is compiled in the World Glacier Inventory (WGI), located at the National Snow and 
Ice Data Center (NSIDC; http://nsidc.org). 

GLIMS
Capitalizing on new developments in the field of remote sensing technologies, GLIMS was initiated to monitor 
the world’s glaciers using data from optical satellite instruments, such as ASTER (Advanced Space-borne Thermal 
Emission and Reflection Radiometre). Because of the enormous variety of glaciers around the world, it is often not 
easy to assign these glaciated forms one unambiguous expression. To ensure consistency and homogeneity in the 
GLIMS glacier database, guidelines for preparing glacier data has been implemented (http://www.glims.org/).

GlobGlacier
GlobGlacier is developing a guidelines for the compilation of glacier inventory data from digital sources. The 
structure of this document follows closely the original guidelines provided by Müller et al., (1977) for the former 
World Glacier Inventory (WGI). The main idea behind this document is to provide a selection of topographic glacier 
parametres and other attributes that can be calculated automatically from glacier outlines and a DEM. The glacier 
data should be provided when possible to the GLIMS database. A set of further parametres is also listed as ‘nice-to 
have’ but not mandatory. 

GlobGlacier has been designed to help in the efficient compilation of glacier-inventory parametres from digital 
sources (vector outlines, digital elevation models or DEMs) and focuses on basic glacier parametres that are required 
in any compilation. 

ICIMOD
Over the course of ICIMOD’s work on glaciers starting in 1999, we categorize the work in terms of approaches – 
old and new. 

Old Approach
The old methodology was based on the instructions for compilation and assemblage of data for the WGI, as 
developed by the Temporary Technical Secretary (TTS) at the Swiss Federal Institute of Technology, Zurich (Muller et 
al., 1977). It was based on the visual interpretation and manual digitization of glacier boundaries followed by the 

Table 2.1:  The attributes used in old approach of the glacier inventory

S.N. Attributes S.N. Attributes S.N. Attributes

1 Glacier ID 7 Map code 1996’s 13 Elevation highest

2 Glacier name 8 Aerial photo number 14 Mean elevation

3 Latitude 9 Image number 15 Elevation of tongue

4 Longitude 10 Max length (km) 16 Classification (TTS)

5 Total area (km2) 11 Orientation accumulation 17 Mean thickness

6 Map code 1960’s 12 Orientation ablation 18 Reserves of ice
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integration of a non-spatial database. The inventory of glaciers has been systematically carried out for the drainage 
basins on the basis of topographic maps, which were published from 1963 to 1982, and satellite images from 
1999 and 2000 to complement. The data represented a wide temporal range since it were derived from these 
different sources. As the method was completely manual it took nearly two years for three full-time professionals to 
compile the inventory for Nepal and Bhutan alone. 

New Approach
There is a need for a glacier mapping method that can deliver glacier data quickly and is consistent with stablished 
international inventory systems to support global climate change research and adaptation studies. It is also important 
to compile glacier information from a single source representing a narrow temporal range to enable precise glacier 
change assessment in both spatial and temporal contexts. To achieve this objective, a customized approach 
using satellite images (Landsat) from a single source from 2005 ± 3 years has been developed. To expedite the 
process, delineation of glaciers is being carried out in semi-automatic fashion using an object-based classification 
approach. Since spectral characteristics of clean ice (CI) and debris covered (DC) ice are different and involve 
different algorithms for classification, each of these types (CI and DC) are catalogued differently and later merged 
into a single layer. Post-classification data management and parametreization are done in a GIS environment. This 
methods allows collection of additional attributes including glacier ID, name, location, area, elevation, slope, length, 
thickness, ice reserves, and classification. Table 2.2 presents each of the 19 columns. 

Table 2.2:  List of attributes of the glacier used in new approach of the glacier inventory

S.N. Attributes S.N. Attributes S.N. Attributes

1 Local ID 7 Debris cover area (km2) 13 Aspect 

2 GLIMS ID 8 Glacier area (km2) 14 Slope (°)

3 Latitude (°) 9 Max elev. of CI (masl) 15 Maximum length (km)

4 Longitude (°) 10 Min elev. CI (masl) 16 6 digit classification

5 Name 11 Max. elev. of DC (masl) 17 Morphological classification

6 CI area (km2) 12 Min. elev. of DC (masl) 18 Average thickness (km)

19 Reserves of ice (km3)
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3.	Glacier Inventories

3.1	 Glacier Inventory of the Hindu Kush Himalaya Based on Topographic 
Maps

Homogeneous and comprehensive glacier data from the HKH was not available till 2000. Only sporadic 
information on glaciers was available, based on which estimates regarding glaciers in the HKH were made. 
The result deviated from the facts and figures. ICIMOD initiated an inventory of the glaciers and glacial lakes of 
Nepal and Bhutan in 1999 with the support of the United Nations Environment Programme Regional Resource 
Centre for Asia and the Pacific (UNEP/RRC-AP). The first digital glacier database based on the topographic maps 
of Nepal and Bhutan was published in 2001. The inventory was further extended to include Himachal Pradesh 
(HP), Uttarakhand (UA), and Sikkim in India; the Indus basin in Pakistan, and the Ganges basin in China. The 
Asia Pacific Network (APN) for Global Change Research, and the Global Change System for Analysis Research 
and Training (START) supported the effort along with partner institutes in each country: Chaudhary Sarwan Kumar 
Himachal Pradesh Agricultural University (CSKHPAU), and Wadia Institude of Himalayan Geology (WIHG), 
India; Water Resource Research Institute (WRRI), Pakistan, and National Centre of Encellence Geology (NCEG), 
Pakistan; Department of Geology and Mines (DGM), Bhutan; Bureau of Hydrology Tibet (BHT), and Cold and Arid 
Regions Environmental and Engineering Research Institute (CAREERI), China; and the Deaprtment of Hydrology and 
Meteorology (DHM), Kathmandu University (KU), Tribhuvan University (TU), and the Water and Energy Commission 
Secretarial (WECS), Nepal (Figure 3.1). 

The database of glaciers and glacial lakes was derived from topographic maps from 1963 to 1982, and satellite 
images from 1999 and 2000 when topographic maps were not available. Before 2011, there were some regional 
gaps, particularly in Myanmar, Afghanistan, China, and some parts of India (Table 3.1).

Figure 3.1:  Regions where glacier inventories were carried out by ICIMOD along with  
national partners from 1999 to 2004
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6

3.2	 Glacier Inventory of Hindu Kush Himalayan Basins-based on Satellite 
Images 

A glacier inventory of the HKH was started in 2010 using a semi-automatic mapping method delineating glaciers 
larger than 0.02 km2 from Landsat satellite images taken between 2002 and 2008. A total of 54,252 individual 
glaciers were mapped with an overall area of 60,054 km2, and estimated ice reserves of 6,100 km3 (Bajracharya 
et al., 2011) (Figure 3.2, Table 3.2). The total estimated ice reserves are equal to roughly three times the annual 
precipitation over the entire HKH (Bookhagen and Burbank 2006; Immerzeel et al., 2009). In total, 1.4% of the 
HKH is glaciated. In terms of debris cover or clean-ice glacier type, altogether 28,500 glaciers were found with a 
glaciated area of 32,000 km2 were found. The debris cover was estimated to be 9.3%, 11.06%, and 12.6% in 
the Indus, Brahmaputra, and Ganges basins respectively. Overall, 9.7% of the total glacier area in the HKH was 
debris-covered. Debris-covered glaciers are mostly valley glaciers with thick debris cover at the glacier tongue. The 
inventory found debris-covered glaicers had an average slope of around 12°, whereas clean-ice glaciers were much 
steeper with average slopes of around 25°. There was a large variation in glacier elevation range, with the lowest 
glacier terminus identified at 2,409 masl in the Indus basin, and the highest at 8,806 masl in the Koshi basin. 
Overall, the largest concentration of glaciated area in the HKH was found at altitudes between 5,000-6,000 masl.

Table 3.1:  Summary of glaciers, glacial lakes, and potentially dangerous glacial lakes in the HKH studied by 
ICIMOD from 1999 to 2004 based on topographic maps

River basins Glaciers Glacial lakes

Number Area (km2) Ice reserve (km3) Number Area (km2) Potential danger

Pakistan Indus River 5,218 15,041 2,738.51 2,420 126.35 52

India Sikkim 285 577 64.78 266 20.20 14

India Himachal Pradesh 2,554 4,161 387.35 156 385.22 16

India Uttarakhand 1,439 4,060 475.43 127 2.49 0

TAR China Ganges 1,578 2,864 NA 824 85.19 77

Nepal 3,252 5,324 481.23 2,323 75.70 20

Bhutan 677 1,317 127.25 2,674 106.87 24

Total 15,003 33,344 4,274.55 8,790 796.52 203

 Figure 3.2:  Distribution of glaciers in the Hindu Kush Himalayan basins
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Table 3.3: Summary of glaciers in the HKH, based on country

Countries
Glaciers

Remarks
Number Area (km2) Avg. area Ice reserve (km3) Elevation range

Afghanistan 3,622 2,677.34 0.739 167.662 3,131-7,256

Bhutan 787 680.25 0.864 47.935 4,050-7,230

China/HKH 26,347 29,528.6 1.121 2648.7 2,313-8,823
86% of total

China/all 42,370 43,087 1.017

India 12,830 12,295.58 0.958 1,131.268 3,001-8,331

Myanmar 87 23.99 0.276 0.929 4,256-5,695

Nepal 3,808 4,213.03 1.106 346.70 3,273-8,437

Pakistan 7,339 10,991.63 1.497 1,758.45 2,409-8,566

Total 54,820 60,410.42 1.102 6,101.644 2,313-8,566

The average size of individual glaciers was relatively small (1.1 km2), but most of the ice reserves are found in larger 
glaciers as a result of the volume-area relationship. The largest individual glacier in the HKH is the Siachen Glacier 
in the Indus basin of Karakoram with a total area of 926 km2. The distribution of glaciers across the region is 
shown in Figure 3.2, as is the level of glaciation in individual basins. There were large variations in glaciated areas 
found within each basin with the greatest proportions in the Indus (3.8% of the total basin area within the HKH), 
Brahmaputra (3.2% of the total basin area within the HKH), and Ganges basins (3.7% of the total basin area within 
the HKH).

3.3	 Glacier Inventory of Hindu Kush Himalayan Countries-based on Satellite 
Images

Glaciers are not bound by political borders separating countries. They are transboundary in nature. Because 
boundaries are disputed in some countries, glaciers that lie in such areas are listed under both countries. Hence 
the number and total area of glaciers when gauged based on HKH countries are slightly higher than HKH basins. 
However, such transboundary glaciers are presented here due to the importance of the status of these glaciers 
in each country (Figure 3.3). About 55% of China’s glaciers lie within the territory of the HKH, which amounts to 
26,347 glaciers with a 29,528 km2 glacier area (Table 3.3). The number and area of glaciers in China are highest 
among the HKH countries (Table 3.3). The least number of glaciers were found in Myanmar, and this inventory is 
probably the first to report glaciers in the country.

Table 3.2:  Status of glaciers in the Hindu Kush Himalaya by basins

Basins

Basin area (km2) in

Number Area (km2) Estimated ice reserves 
(km3)Total HKH

Amu Darya 645,726 166,686 3,277 2,566 162.61

Indus 1,116,086 555,450 18,495 21,193 2,696.05

Ganges 1,001,019 244,806 7,963 9,012 793.53

Brahmaputra 528,079 432,480 11,497 14,020 1,302.63

Irrawaddy 426,501 202,745 133 35 1.29

Salween 363,778 211,122 2,113 1,352 87.69

Mekong 841,322 138,876 482 235 10.68

Yangtze 2,065,763 565,102 1,661 1,660 121.40

Yellow 1,073,168 250,540 189 137 9.24

Tarim 929,003 26,729 1,091 2,310 378.64

Interior NA 909,824 7,351 7,535 563.1

Total 8,990,445 3,704,360 54,252 60,054 6,126.85

Note: HKH basin area is 4,192,445 km2 ≈ 4.2 million km2
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 Figure 3.3:  Glaciers in Hindu Kush Himalayan countries
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4.	Decadal Glacier Change

Glaciers in the HKH are receding, some of them at a rate as high as over 70m/year, as in the case of Imja Glacier 
(Bajracharya et al., 2007). Elsewhere in the eastern Himalaya (Bhutan), reported glacier retreat can be as high as 
160m/year, as in the case of the Luggye Glacier from 1988 to 1993 (Mool et al., 2001). Similarly, glacier area 
has decreased by 11.93 km2 in 30 years (1963-1993) in Bhutan, as reported from the observation of 66 glaciers 
(Karma et al., 2003). In the western Himalaya, glacier area decreased from 84.41 km2 to 77.29 km2 from 1976 
to 2003. Observed rates are 0.17, 0.19, and 0.77 km2 per year, on average, during the periods 1976–90, 
1990–99, and 1999–2003, respectively, suggesting that glacier retreat has accelerated in the most recent decade 
(Ye et al., 2006). Observers noted that smaller glaciers exhibit a higher retreat rate than larger glaciers.

The Chinese Academy of Sciences has reported that there has been a 5.5% shrinkage in volume of China’s 46,928 
glaciers during the last 24 years, equivalent to the loss of more than 3,000 km2 of ice (Pradhan et al., 2007). 

4.1	 Decadal Glacier Change in Nepal from the 1980s to 2010
The report “Glacier status in Nepal and decadal change from 1980 to 2010 based on Landsat data”, published 
in 2014, presents a comprehensive assessment of the status of Nepal’s glaciers in 2010 and the changes since 
approximately 1980, 1990, 2000, and 2010 (Bajracharya et al., 2014a). A small case study in the Langtang 
and Imja sub-basins provided a more detailed snapshot view of the changes in individual glaciers and small sub-
basins (Figure 4.1) and the possible changes in average temperatures over the past two decades.

Due to shrinking and fragmentation, the number of glaciers had increased by 11% (378) over the 30-year period, 
with the greatest increase between ~1980 and 1990. The glacier area decreased by 24% (1,266 km2) and the 
estimated ice reserves by 29% (129 km3), again with the greatest change between ~1980 and 1990. The overall 
glacier area decreased from 3.6% of the total land area of Nepal to 2.6%. Although the rate of loss of area was 
the same between 1990-2000 and 2000-2010, but the rate of loss of ice reserves increased over this period 
(Table 4.1).

4.2	 Decadal Glacier Change in Bhutan from the 1980s to 2010
A total of 885 glaciers were mapped from the images of 2010, with an area of 642±16.1 km2 (1.6% of Bhutan’s 
total land) (Table 4.2 and Figure 4.2). The Punatsangchu basin has the highest number of glaciers (436) and 
glacier area (361.6±9.3 km2), while the Wangchu basin has the lowest number of glaciers (56) and glacier area 
(32.8±0.7 km2). The largest glacier was G090161E28125N in the Phochu sub-basin of Punatsangchu basin, with 
an area of 36 km2. The glacier elevation ranged from 7,230 masl (in the Manaschu basin) to 4,050 masl (in the 
Punatsangchu basin) (Table 4.3). 

Overall, the glacier number shows an increasing trend, whereas the glacier area shows a decreasing trend in the 
decades from ~1980 to 2010. The number of glaciers had increased by 7%, 5.3%, and 1.2% between ~1980-
1990, 1990-2000, and 2000-2010, respectively, with an overall increase of 14.8% in 30 years (~1980 to 
2010) (Table 4.4). The glacier area had decreased by 11.6±1.2%, 7.1±0.1%, and 6.7±0.1% between the 
decades ~1980-1990, 1990-2000, and 2000-2010, respectively, with an overall decrease of 23.3±0.9% 
in 30 years. The average glacier area in ~1980 was greater than 1 km2 but decreased to less than 1 km2 in 

Table 4.1:  Status and decadal change of glaciers in Nepal from 1980 to 2010

Glaciers
Decade (year) Decadal change
~1980 1990 2000 2010 ~1980 – 1990 1990 – 2000 2000 – 2010 ~1980 – 2010

Number 3,430 3,656 3,765 3,808 +226 +7% +109 +3% +43 +1% +378 +11%

Area (km2) 5,168 4,506 4,211 3,902 -662 -13% -295 -7% -308 -7% -1,266 -24%
Estimated ice 
reserves (km3) 441 370 343 312 -72 -16% -27 -7% -31 -9% -129 -29%
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4. Decadal Glacier Change

Table 4.2:  Decadal clean-ice (CI) and debris-covered (DC) glacier area change from ~1980 to 2010

Years
Glacier area (km2) Change in glacier area (%)

CI DC Total CI DC Total

~1980 757.4±26.05 80.2± 1.61 837.6± 28.81

1990 654.6± 14.74 86.2± 0.96 740.7± 16.67 -13.6± 1.2 7.5 ± 0.9 -11.6± 1.2

2000 598.2 ± 14.3 90 ± 0.79 688.2± 16.45 -8.6 ± 0.1 4.4 ± 0.2 -7.1 ± 0.1

2010 550.7± 13.83 91.4± 0.71 642.1± 16.12 -7.9 ± 0.1 1.6 ± 0.1 -6.7 ± 0.1

~1980-2010       -27.3± 0.9 13.9± 1.2 -23.3± 0.9

Figure 4.1:  (a) Distribution of glaciers in Nepal and decadal glacier change of Nepal. (b) Langtang valley  
	       (c) Imja valley

a

b c

Note: Country boundary are unauthorized
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Table 4.3:  Decadal glacier area change in Jhelum basin

SN Year Glacier number
Glacier area Ice reserves

Largest glacier 
area (km2)

Elevation (masl)

(km2) (km3) Highest Lowest

1 2010 846 211.16 8.36 6.25 6,285 3,520

2 2000 845 220.83 8.82 6.33 6,285 3,520

3 1990 823 248.15 10.04 6.53 6,285 3,520

4 1980 817 268.57 10.96 6.86 6,285 3,527

Figure 4.2:  (a) Distribution of glaciers in Bhutan and (b) decadal change of glaciers in  
Lunana region from 1980s to 2010

a
b

consecutive decades due to an increase in glacier number and decrease in glacier area. The increase in number 
with concomitant loss of glacier area indicates fragmentation of existing glaciers due to shrinking rather than the 
development of new glaciers. Nonetheless, glacier number had slightly decreased in 2010 due to the dissolution of 
glaciers on steep slopes. 

In the context of global warming, with the rise of temperature, the glaciers are melting rapidly, resulting in the 
subsiding, shrinking, and retreating of glaciers. The observations of individual glaciers indicate that the annual retreat 
rates vary from basin to basin and in some instances, with a doubling of the rate in recent years compared to the 
early seventies. Given these contexts, the present status of glacier information is of utmost important, which requires 
regular updates in order to understand the dynamics of the cryosphere and its impact in the present context.

4.3	 Decadal Glacier Change in Jhelum Basin from the 1980s to 2010
The Jhelum River catchment forms a transboundary basin extending into India and Pakistan. The basin extends 
from latitude 33.47° to 35.11° N and longitude 73.42° to 75.59°E (Figure 4.3). It is one of the major eastern 
tributaries of the Indus River. Most of the glaciers are distributed at the higher elevation of the northern sector 
(Table 4.3). 

The glaciers in the Jhelum basin were mapped from the Landsat images of 1980s, 1990, 2000, and 2010 for the 
decadal glacier change. The results show that the basin contained 268.57 km2 of glacier area in 1980, 248.15 
km2 in 1990, 220.83 km2 in 2000, and 211.16 km2 in 2010. There is a decrease of 21% in glacier area as 
compared from 1980 to 2010 data. The rapid melting of glaciers was observed between 1990-2000, during 
which the area decreased by 11%. The retreat rate of glaciers was found to be lowest (4.4%) during 2000-2010. 
The largest glacier (GLIMS ID G074442E35102N), which had an area of 6.86 km2 in 1980, has reduced to 
6.25 km2 in 2010. The glacier does not show comparative change at the snout over these decades.



13

4. Decadal Glacier Change

Figure 4.3: Distribution of glaciers in 2010 in Jhelum basin
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5.	Data Sources for Glacier Inventory

Due to global warming, the rapid melting of glaciers has changed the glacial scenario significantly. To understand 
the behavior of individual glaciers, it is necessary to make the inventory of glacier such that the variation in each 
glacier can be monitored separately. The fast delivery of glacier inventory could be possible with the aid of satellite 
images, digital elevation models, and topographic maps. 

5.1	 Satellite Remote Sensing
Satellite data refers to images acquired by sensors (cameras) onboard satellite vehicles hovering in space. Since the 
launch of Sputnik by the former Soviet Union in 1957 there are various sensors that provide comprehensive pictures 
of the Earth’s surface and processes a wide range of spatial, temporal and spectral resolutions. Figures 5.1 and 5.2 
compare satellite images characteristics from different sensors. 

Because glaciers are remote, satellite remote sensing is a key application in glacier mapping. Glaciers show 
different spectral reflectance parametres, which helps to identify them in satellite data and delineate their planimetric 
outline. Since the early 1970s, when the possibility of satellite data to map glaciers was first demonstrated, remote 
sensing has been used constantly in glacier mapping studies. The Landsat Multispectral Scanner (MSS) was one of 
the first satellites used for glacier mapping by the United States Geological Survey (USGS). Different sensors have 
been used for glacier mapping over time. Table 5.1 summarises some of the sensors commonly used for glacier 
mapping and their characteristics. 

The most common characteristic of the various satellite remote sensing systems results from the spatial, temporal, 
and spectral resolutions. The spatial resolution specifies the pixel size of satellite images covering the earth surface. 
The temporal resolution specifies the revisiting frequency of a satellite sensor for a specific location. The spectral 
resolution specifies the number of spectral bands in which the sensor can collect reflected radiance. But the number 
of bands is not the only important aspect of spectral resolution; the position of bands in the electromagnetic spectrum 
is also important.

Remote sensing systems with spatial resolution of more than 1km are generally considered low resolution systems. 
MODIS and AVHRR are some of the very low resolution sensors. When the spatial resolution is 100m-1km, it is 
considered a moderate resolution system. IRS WiFs (188m), band 6 (120m) of the Landsat TM, and bands 1-7 
of MODIS (250-500m) are moderate resolution sensors. When the spatial resolution is in the range of 5-100m, 
the sensor is considered a high resolution system. Landsat ETM+(30m), IRS LISS-III (23MSS and 6m Panchromatic), 
AWiFS (56-70m), and SPOT 5 (2.5-5m Panchromatic) are some of the high resolution sensors. Very high resolution 
systems can provide spatial resolution of less than 5m. GeoEye, IKONOS, and QuickBird are a few examples of 
very high resolution systems (Figures 5.1 and 5.2). 

Many remote sensing systems are multi-spectral; they record energy over separate wavelength ranges at various 
spectral resolutions. For example, IRS LISS-III uses four bands: 0.52-0.59 (green), 0.62-0.68 (red), 0.77-0.86 (near 
IR), and 1.55-1.70 (mid-IR). The Aqua/Terra MODIS instruments use 36 spectral bands, including three in the visible 
spectrum. A recent development is the hyper-spectral sensors – for instance, MODIS (36 bands) and AVIRIS (224 
bands) – which detect hundreds of very narrow spectral bands. A range of features are identified from the image by 
comparing their responses over different distinct spectral bands. Water and vegetation can be easily separated using 
very broad wavelength ranges such as visible and near-infrared (Figure 5.1). 

The higher the temporal resolution, the shorter the length of time between the acquisitions of images. 
Many satellites have a medial temporal resolution of about 14-16 days (IKONOS: 14 days, LANDSAT 7: 16 days). 
But there are also satellites with a very high temporal resolution capable of acquiring images of the same area every 
15 minutes (meteorological satellites such as METEOSAT 8). Satellite sensors with a low temporal resolution (SPOT, 
IKONOS, QuickBird) are very useful for acquiring images of a certain area only once or twice a month and have 
a better spatial resolution than sensors with a resolution of, for instance, 1000m, providing images once an hour 
(Figure 5.2).
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Figure 5.1:  Comprehensive picture of earth’s surface and processes at wide range of spatial and spectral 
resolutions 

Spatial Resolution in metres
Source: Jensen J. et. al., (n.d.)
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Figure 5.2:  Comprehensive picture of earth’s surface and processes at wide range of spatial and temporal 
resolutions 

Spatial Resolution in metres

Source:  Jensen, J.R. and Cowen, D.C.  (1999) 
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Table 5.1:  Optical land imaging satellites with 56 metres or better resolution by launch date

Satellite Country Launch date Panchromatic 
resolution (m)

Multspectral 
resolution (m)

Swath (km)

Landsat 5 US 03/01/84 30.0 185

SPOT-2 France 01/22/90 10.0 20 120

IRS 1D India 09/29/97 6.0 23 70; 142

Proba ESA 10/21/97 18 Hyp 14

SPOT-4 France 03/24/98 10.0 20 120

Landsat 7 US 04/15/99 15.0 30 185

IKONOS-2 US 09/24/99 1.0 4 11

TERRA (ASTER) Japan/US 12/15/99 15; 30; 90 60

KOMPSAT-1 Korea 12/20/99 6.6 17

EO-1 US 11/21/00 10.0 30 37

EROS A1 Israel 12/05/00 1.8 14

QuickBird-2 US 10/18/01 0.6 2.5 16

SPOT-5 France 05/04/02 2.5 10 120

DMC AlSat-1 (SSTL) Algeria 11/28/02 32 600

DMC BilSat (SSTL) Turkey 09/27/03 12.0 26 24; 52

DMC NigeriaSat-1 (SSTL) Nigeria 09/27/03 32 600

DMC UK (SSTL) UK 09/27/03 32 600

IRS ResourceSat-1 India 10/17/03 6.0 6; 23; 56 24; 140; 740

CBERS-2 China/Brazil 10/21/03 20.0 20 113

FORMOSAT-2 Taiwan 04/20/04 2.0 8 24

IRS Cartosat 1 India 05/04/05 2.5 30

MONITOR-E -1 Russia 08/26/05 8.0 20 94; 160

Beijing-1 (SSTL) China 10/27/05 4.0 32 600

TopSat (SSTL) UK 10/27/05 2.5 5 10; 15

ALOS Japan 01/24/06 2.5 10 35; 70

EROS B1 Israel 04/25/06 0.7 7

Resurs DK-1 (01-N5) Russia 06/15/06 1.0 3 28

KOMPSAT-2 Korea 07/28/06 1.0 4 15

IRS Cartosat 2 India 01/10/07 0.8 10

WorldView -1 US 09/18/07 0.5 16

CBERS-2B China/Brazil 09/19/07 20.0 20 113

THOES Thailand 02/27/08 2.0 15 22; 90

RazakSat* Malaysia 03/01/08 2.5 5 ?

HJ-1-A China 04/01/08 30; 100 Hyp 720; 50

HJ-1-B China 04/01/08 30; 150; 300 720

RapidEye-A Germany 04/01/08 6.5 78

RapidEye-B Germany 04/01/08 6.5 78

RapidEye-C Germany 04/01/08 6.5 78

RapidEye-D Germany 04/01/08 6.5 78

RapidEye-E Germany 04/01/08 6.5 78

SumbandilaSat South Africa 04/01/08 7.5 ?

X-Sat Singapore 04/16/08 10 50

Hi-res Stereo Imaging China 07/01/08 2.5, 5 10 ?

WorldView -2 US 07/01/08 0.5 1.8 16

Venus Israel/France 08/01/08 10 28

GeoEye-1 US 08/23/08 0.4 1.64 15

DMC Deimos-1 Spain 11/15/08 22 660
Cont...
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Satellite Country Launch date Panchromatic 
resolution (m)

Multspectral 
resolution (m)

Swath (km)

DubaiSat-1 UAE 11/15/08 ? ? ?

DMC UK-2 UK 11/15/08 22 660

Alsat-2A Algeria 12/01/08 2.5 10 ?

IRS ResourceSat-2 India 12/15/08 6.0 6; 23; 56 24,140; 740

EROS C Israel 04/01/09 0.7 2.8 11

CBERS-3 China/Brazil 05/01/09 5.0 20 60; 120

TWSAT India 07/01/09 35 140

DMC NigeriaSat Nigeria 07/01/09 2.5 5; 32 320

ARGO Taiwan 07/01/09 6.5 78

KOMSAT-3 Korea 11/01/09 0.7 3.2 ?

Alsat-2B Algeria 12/01/09 2.5 10 ?

Pleiades-1 France 03/01/10 0.7 2.8 20

CBERS-4 China/Brazil 07/01/10 5.0 20 60; 120

SeoSat Spain 07/01/10 2.5 ?

Pleiades-2 France 03/01/11 0.7 2.8 20

EnMap Germany 07/01/11 30 Hyp 30

LDCM US 07/01/11 10.0 30 177

SPOT France 07/01/12 2.0 6 60

Sentinel 2 A ESA 07/01/12 10; 20; 60 285

Sentinel 2 B ESA 07/01/13 10; 20; 60 285

Landsat 8 OLI US 02/11/13 15 30; 100 185

Commercial * Near Equatorial Orbit Revised 1/21/08

Note: Read 4/1 = 1st quarter, 7/1 = in that year, 11 & 12s = late in that year

5.2 	 Digital Elevation Model (DEM)
Digital elevation models (DEMs), which are digital representations of the Earth’s relief, are one of the most important 
data structures used for geomatics and geoscientific analysis. Topographic information is required for geometric, 
radiometric, and atmospheric corrections of satellite data from optical and microwave instruments. When combined 
with a DEM, glacier outlines derive glacier parametres such as hypsometry, minimum/median elevations, and ELA. 
Recent studies incorporate slope information from DEM to study glacier dynamics. It can be generated using stereo 
satellite/photo pairs or by interpolating relief information like contour (line) and/or height (point) data. 

Shuttle Radar Topography Mission (SRTM) DEM
The Shuttle Radar Topography Mission (SRTM) is a joint project between the National Geospatial-Intelligence 
Agency (NGA) and the National Aeronautics and Space Administration (NASA). The SRTM obtained elevation data 
on a near-global (80%) scale to generate the most complete high-resolution digital topographic database of Earth. 
(Figure 5.3 shows the global coverage map of SRTM.) SRTM consists of a specially modified radar system that maps 
the earth’s topography. A technique called Interferometric Synthetic Aperture Radar is used to send the signal to the 
ground, where it is picked up by radar, and then transformed to produce topographic data. (The SRTM index map 
used for the HKH is shown in Figure 5.4.)

The SRTM can map the earth’s topography at a 30m spatial resolution, but data with such resolution have only been 
released over the United States territory and some isolated areas; for the rest of the world, 90m data are available. 
The elevation models are arranged into tiles, each covering one degree of latitude and one degree of longitude, 
named according to their southwestern corners. In 2005, NASA released version 2 of the SRTM digital topographic 
data (also known as the “finished” version), which has undergone substantial editing. 

Table 5.1:  Optical land cont...
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Advanced Spaceborne Thermal Emission and Reflection Radiometre (ASTER) DEM
ASTER (Advanced Spaceborne Thermal Emission and Reflection Radiometre) is an imaging instrument flying on Terra, 
a satellite launched in December 1999 as part of NASA’s Earth Observing System (EOS). ASTER is a cooperative 
effort between NASA, Japan’s Ministry of Economy, Trade and Industry (METI), and Japan’s Earth Remote Sensing 
Data Analysis Center (ERSDAC). ASTER, with its along-track stereo, has the capability to generate precise DEM. 
METI and NASA announced the release of the ASTER Global Digital Elevation Model (GDEM) on June 29, 2009. 
The GDEM was created by stereo-correlating the 1.3 million-scene ASTER VNIR archive, covering the Earth’s land 
surface between 83°N and 83°S latitudes. The GDEM is produced with 30 metre postings, and is formatted in 1 x 
1 degree tiles as GeoTIFF files. ASTER-DEM is suitable for terrain analysis in a GIS environment at 1:25,000 scale. 
Each GDEM file is accompanied by a Quality Assessment file, either giving the number of ASTER scenes used to 
calculate a pixel’s value or indicating the source of external DEM data used to fill the ASTER voids. The GDEM is 
available for download from NASA’s EOS data archive and Japan’s Ground Data System. Global DEM like Shuttle 
Radar Topography Mission (SRTM) DEM and ASTER DEM are freely available in the public domain.

Figure 5.3: Global coverage map of SRTM

Source: NASA

Table 5.2:  Overview of DEM generation from satellite images (<15m)

IKONOS QUICKBIRD EROS-A1 SPOT-5/
HRG

SPOT-5/
HRS

IRS-PAN 
1C/1D

ASTER-
VNIR PRISM

Bands PAN, RGB, 
NIR

PAN, RGB, 
NIR PAN PAN PAN PAN G, R,

NIR PAN

Ground resolution (m) 14 0.61, 2.44 2.6 2.5,5 10(5) 5 15 2.5

Stereo acquisition Along/Across Along/Across Along/Across Across Along Across Along

Scene size (km x km) 11 x 11 16.5 x 16.5 12.5 x 2.5 60 x 60 120 x 60 70 x 70 60 x 60 35 x 35/70
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Figure 5.4:  SRTM index map of the HKH 
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6.	Glacier Inventory Methodology  
(New Approach)

The inventory of glaciers carried out by ICIMOD in 2001 was based on the topographic maps published from 
1963 to 1982 and complemented by satellite images from 1999 and 2000. This information thus was captured 
from different sources with a wide temporal range. However, this work provided firsthand baseline information on 
glaciers and glacial lakes. But for scientific analysis of glaciers and glacial lakes, one must keep the source and date 
in the least diverse form possible. Keeping this in mind, a new quick inventory methodology has been developed to 
generate a glacier and glacial lake inventory database based on the single source of narrow temporal ranges. The 
readily available data sets are satellite images which are downloadable free of cost, such as Landsat 5, Landsat 
7 TM, and Landsat 7ETM+. It is difficult to manage high quality images of one year covering the whole area of 
interest; thus, one has to use images covering a non-negligible temporal range. The satellite images (Landsat 5, 
7, ETM+) of 2005 ±3 years are selected for the inventory of the glaciers, which will provide the status of glaciers 
in the region and baseline information for scientific analysis. The information will be purely based on the remote 
sensing approach, and management of the database will be done in a GIS environment; accordingly, the attribute 
information of the glaciers will be limited. 

The glacier mapping and inventory will be carried out with a semi-automated approach and will map glacier 
outlines using multispectral (optical) satellite data using eCognition software (formerly known as Definion Developer). 
The attribute parametres will be based on the “Guidelines for the compilation of glacier inventory data from digital 
sources”, which was reviewed and commented on by several members of the GlobGlacier working and user group, 
as well as the GLIMS community. The original structure of the inventory follows closely the original guidelines by 
Müller et al., (1977) for the former World Glacier Inventory (WGI).

All perennial snow and ice masses will be mapped for the glacier inventory using geo-referenced Landsat-5/7/
ETM+ by implementing algorithms based on the semi-automatic approach. Semi-automatic object-based 
classification will be implemented in eCognition software and post- classification data management will be done in 
ArcGIS. Pre-classification preparatory processes, such as mosaicking different scenes of images and defining and 
clipping out areas of interest, will be done in Erdas Imagine. 

6.1 	 Semi-automatic Glacier Mapping
Spectral uniqueness of glacier ice in the visible and near-IR part of the electromagnetic spectrum enables algorithm-
based semi-automatic mapping of glaciers, in contrast to the tedious manual approach. Of the two kinds, Clean Ice 
(C-type) and Debris covered (D-type) glaciers, the latter poses challenges in illuminating errors due to effects from 
surrounding materials in the semi-automatic mapping process. To minimize errors, the morphometric classification 
approach using morphological variables like slope should be employed. 

Keeping in mind the spatial scalability of features, object-based multiresolution segmentation is possible in eCognition 
software, which enables the extraction of information in different resolutions. This multiresolution segmentation 
divides the image into object primitives. It is important to assign appropriate shape and compactness factors during 
segmentation. Segmentation is of major significance in the entire process since it influences the final quality of the 
classified data. In glacier mapping, visible and near infrared bands are used during segmenting. 

As mentioned earlier, different approaches must be adopted for classifying C- and D-types of glaciers. From our 
experience, using a threshold value of Normalized Difference Snow Index (NDSI) for C-type and a mean slope 
for D-type have mapped all glacier pixels. Further filtering using different variables such as Normalized Difference 
Vegetation Index (NDVI) (for vegetation), land and water mask (water bodies), mean hue, mean slope, and mean 
altitude (glaciers) will eliminate any misclassified objects such as water bodies, shadows, rocks, and trees from the 
classified image of the glacier (Figure 6.1). 
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6.2 	 Spectral Signatures
Glacier ice mapping relies on the spectral uniqueness of glacier ice in the visible and near-infrared part of the 
electromagnetic spectrum (Table 6.1). Snow and ice are characterized by: 1) high reflectivity (albedo) in the visible 
wavelengths (0.4-0.7 μm); 2) medium reflectivity in the near-infrared (0.8-2.5 μm); 3) low reflectivity and high 
emissivity in the thermal infrared (2.5-14 μm); and 4) low absorption and high scattering in the microwave (Rees et 
al., 2003). 

Table 6.1:  Spectral bands (µm) details of Landsat ETM+ and its potential applications

Band Range (µm) Spectral Potential applications

1 0.45–0.52 Blue Coastal water mapping; soil/vegetation differentiation; deciduous/coniferous 
differentiation (sensitive to chlorophyll concentration), etc.

2 0.52–0.62 Green Green reflectance by healthy vegetation, etc.

3 0.63–0.69 Red Chlorophyll absorption for plant species differentiation 

4 0.78–0.90 NIR Biomass surveys; water body delineation

5 1.55–1.75 Infrared (MIR) Vegetation moisture measurement; snow/cloud differentiation; snow and ice study 

6 10.4–12.5 ThIR Plant heat stress management; other thermal mapping; soil moisture discrimination

7 2.08–2.35 IIR Hydrothermal mapping; discrimination of mineral and rock types; snow/cloud 
differentiation; snow/ice study

For the delineation of clean and debris cover-type glaciers, the following variables are used:

Brightness: Sum of the mean values of the layers containing spectral information divided by their quantity computed 
for an image object (mean value of the spectral mean values of an image object).

NDSI: Normalized Difference Snow Index (NDSI) is analogous to the normalized difference ice index and is the 
normalized difference of spectral reflectance values between the visible (green) and short wave-infrared (SWIR). This 
is the ratio between the difference of spectral reflectance of band 3 and 5 to the sum of spectral reflectance of band 
3 and 5 (Table 6.1). It is used to identify whether the pixel contains snow or ice. 

	 NDSI = (VIS-MIR)/(VIS+MIR)

If you are using the Landsat 7etm+ 

NDSI = ([Mean Layer 2]-[Mean Layer 5])/([Mean Layer 2]+[Mean Layer 5])
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Figure 6.1:  Flow diagram on methodology for glacier mapping using satellite images
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NDVI: Normalized Difference Vegetation Index is the normalized difference between red and near infrared (NIR) 
and is used in the identification of vegetation in the pixel(s).  

NDVI = ([Mean Layer 3]-[Mean Layer 4])/([Mean Layer 3]+[Mean Layer 4])

NDWI: Normalized Difference Water Index is analogous to NDVI but is related to the assessment of water content in 
a normalized way. It is the ratio of the difference of NIR and SWIR to the sum between the two. 

DVI: Differential vegetation Index is the difference between near infrared and red bands and is ideal for biophysical 
properties of vegetation.

RVI: Ratio vegetation index is the ratio between near infrared and red bands and is used mostly for leaf area index 
characterization.

Red/Infrared: Normalized difference between red and infrared. This is the ratio between the difference of spectral 
reflectance of band 3 and band 4 to the sum of spectral reflectance of band 3 and 4.

Standard deviation (Layer 3): It is calculated from the image layer intensity values of all pixels forming an image 
object. It is preferable to use band 3 of Landsat 7ETM+. 

HSI: Hue, the quality of a color as determined by its dominant wavelength. It is nothing but the color (blue, red, 
yellow, etc.) we describe; Saturation: the strength of a color with respect to its value or lightness; Intensity: the 
brightness or dullness of a hue (color). 

The HSI color space is very useful for image processing because it separates the color information in ways that 
correspond to the human visual system’s response. The hue value of the HSI color space represents the gradation of 
color.

Max. Diff.: Maximum Spectral Difference is defined as the amount of spectral difference between the mean intensity 
of image objects divided by the brightness of image objects. 

Asymmetry: Asymmetry is the relative length of an image object compared to a regular polygon. The longer an 
image object, the more asymmetric it is. An ellipse is approximated around a given image object, which can be 
expressed by the ratio of the lengths of the minor and the major axis of this ellipse. The feature value increases with 
the asymmetry.

DEM: Topographic information such as elevation and slope play a crucial role in the identification of glaciers. This 
information is derived from a digital elevation model (DEM). A DEM is used to derive crucial glacier parametres such 
as minimum/median elevation, equilibrium line altitude (ELA), and hypsometry. The SRTM (Shuttle Radar Topography 
Mission) DEM at a spatial resolution of 90 metres is used for glacier study. 

Slope: The general slope of the debris cover glacier in the mountain is less than 15 degrees, whereas the clean ice 
can remain at a slope of above 30 degrees. 

Area: Surface area of the glaciers. The area of the clean ice less than 0.02 km2 is not accounted here for the 
inventory of glaciers in the Himalaya.

6.3 	 Glacier Inventory Parametres
All polygons delineated for the present glacier inventory are coded, and attribute parametres are derived for 
each glacier polygon in ArcGIS. The coding system is based on the one used in the World Glacier Inventory. The 
descriptions of attributes for the inventory of glaciers are given below.

Glacier ID
Local ID: The Glacier ID is assigned by numbering the glaciers starting from the outlet of the major stream of a basin 
and proceeding clockwise around the basin through each significant small tributary (e.g., Ktrgr_123).
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GLIMS ID: The Glacier ID is based on the latitude and longitude location of a “center point” on the glacier. The 
GLIMS ID is a 14-digit code including G for Global, E for East, and N for North. The latitude and longitude should 
be in degrees defined to three decimal places (e.g., G086700E28016N).

Latitude and Longitude
The location of the glacier is described using the central coordinates (latitude and longitude) of the glacier polygon. 
The latitude and longitude are stored in degrees defined to three decimal places.

Name
The name is inserted manually from the map or from an existing glacier inventory (if available).

Area of the Glacier
The area will be calculated separately for Clean Ice (CI) and Debris-covered (DC) glaciers, and the latter will be 
merged to make one glacier. Glaciers with an area of less than 0.2 sq.km. will be dropped out and the area will be 
presented in square kilometres with two digits after the decimal point.

Elevation of the Glacier
Glacier elevation is divided into highest elevation (the highest elevation of the crown of the glacier) derived from the 
Clean Ice (CI), mean elevation (the arithmetic mean value of the highest glacier [CI] elevation and the lowest glacier 
[CI or DC] elevation), and lowest elevation (elevation of the tongue of the glacier) derived from the Debris-covered 
(DC) ice. If the glacier is not debris-covered, the tongue of the clean ice is considered the lowest elevation. It is 
measured in metres above sea level (masl).

Orientation of the Glacier
The orientation of Clean Ice (C type) and Debris-
covered (D type) glaciers is represented in eight 
cardinal directions (N, NE, E, SE, S, SW, W, and 
NW) (Figure 6.2). Each cardinal direction has a 
range of 45 degrees, half to each side, as shown 
in Figure 6.2. Some glaciers are ice caps forming 
an apron around a peak and thus sloping in all 
directions; such glaciers were represented as “open.” 
The orientations of C and D type glaciers in the 
compound basins can be different. 

Mean Slope
The mean slope was derived for each glacier from the 
DEM; it is independent of glacier length and refers 
to all individual cells of the DEM within the glacier 
boundary (cf. Manley 2008). The mean slope is a 
rough proxy for other parametres like mean thickness 
(cf. Haeberli and Hoelzle 1995) and also relates to 
other dynamic measures, such as surface flow speed.

Length of the Glacier
The length of the glacier is divided into three columns: total length, length of Clean Ice, and length of Debris-
covered ice. The total (maximum) length refers to the longest distance of the glacier along the centerline. It is 
measured manually and presented in metres.

Figure 6.2:  Aspect quadrants
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Mean Glacier Thickness and Ice Reserves
There are very few measurements of glacial ice thickness for the southern flank of the Himalaya. Measurements of 
glacial ice thickness in the northern flank (Tianshan Mountains, China) show that the glacial thickness increases with 
the increase of its area (LIGG/WECS/NEA 1988; CAREERI 2008). The relationship between ice thickness (H) and 
glacial area (F) was obtained by using the empirical formula 

H = –11.32 + 53.21 F 0.3

This scaling formula was used to estimate the mean ice thickness of the glaciers. However, the value is a tentative 
figure and highly uncertain, since surface slope, annual mass balance, and many other attributes affect ice thickness. 
The ice reserves were estimated from the mean ice thickness multiplied by the glacial area. The value is also highly 
uncertain, as it is derived from the already highly uncertain glacier thickness.

Morphological Classification
A morphological matrix-type classification and description was used in the study in line with the classification 
proposed by Muller et al., (1977) for the TTS to use in the WGI. Each glacier was coded as a six-digit number, 
one digit for each of six different morphological characteristics (Table 6.2). The individual numbers for each digit 
(horizontal row numbers) are read on the left-hand side. This scheme is a simple key for the classification of glaciers 
all over the world.

Table 6.2:  Classification and description of glaciers

Digit 1 Digit 2 Digit 3 Digit 4 Digit 5 Digit 6

Primary classification Form Frontal 
characteristic

Longitudinal profile Major source of 
nourishment

Activity of tongue

Uncertain or 
miscellaneous

Uncertain or 
miscellaneous

Normal or 
miscellaneous

Uncertain or 
miscellaneous

Uncertain or 
miscellaneous

Uncertain

Continental ice sheet Compound basins Piedmont Even: regular Snow and/or drift snow Marked retreat

Ice field Compound basin Expanded foot Hanging Avalanche and/or snow Slight retreat

Ice cap Simple basin Lobed Cascading Superimposed ice Stationary

Outlet glacier Cirque Calving Ice fall Slight advance

Valley glacier Niche Confluent Interrupted Marked advance

Mountain glacier Crater Possible surge

Glacieret and snow 
field

Ice apron Known surge

Ice shelf Group Oscillating

Rock glacier Remnant

6-digit Classification

Digit 1: Primary classification
(Adopted from Illustrated GLIMS Glacier Classification Manual)

The six categories of the parametre group “Primary classification” attempt to classify glaciers into morphologically 
distinct units, which facilitate an identification of almost every type of glacier in the world (Table 6.3). Combining 
these primary classification values with those of other parametre groups, it becomes possible to typify commonly 
known glacier types of which the “primary types” seem to be cirque glaciers, tidewater glaciers, or hanging 
glaciers. 
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Table 6.3:  Primary classification

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations

Definition WGMS Comments Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
– Frontal Characteristics – Longitudinal 
Profile - Major source of nourishment)

GLIMS 
code

Uncertain or 
miscellaneous 

•	 Any type not listed 
below 

Any type not listed 
below 

0 

Continental 
ice sheet 

•	 Unconstrained by 
topography 

•	 Continental size 
•	 Derive their 

morphological 
shape from ice flow 
properties, internal 
dynamics, and 
bedrock conditions 

Inundates areas of 
continental size 

•	 May incorporate 
individual ice domes 

1 

Ice-field •	 Approximately 
horizontal, ice-
covered area 

•	 Ice covering does 
not overwhelm 
surrounding 
topography 

•	 Occur in 
topographical 
depressions or 
plateaus 

•	 No dome-like shape 
(in contrast to ice 
cap) 

•	 Smaller than 
50.000 km2 
(approx. 220 x 220 
km) 

Ice masses of sheet 
or blanket type 
of a thickness not 
sufficient to obscure 
the sub-surface 
topography 

•	 In some cases no 
need to classify 
in “Frontal 
characteristic” (the 
frontal characteristic 
is described by 
the outreaching 
glaciers). 

•	 Might also be used 
to classify low lying 
areas where the ice 
divides and flow 
directions are not 
clearly detectable 
(“transectional 
glaciers”) 

Excluded classification 
combinations: 
–	 Niche 
–	 Apron 
–	 Hanging 
–	 Cascading 
–	 Ice fall 
–	 Interrupted 

Figure 1 – Ice field

Figure 2 – Ice field 

Figure 3 – Ice field – Uncertain or 
miscellaneous – Uncertain or 
miscellaneous – Even, regular– Snow

Figure 4 – Ice field – compound 
basins– Confluent – Even, regular– 
Snow 

Figure 5 – Ice field 

2 

Cont...

Table 6.3 cont...
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Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations

Definition WGMS Comments Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
– Frontal Characteristics – Longitudinal 
Profile - Major source of nourishment)

GLIMS 
code

 

Figure 6 – Ice field
Ice cap •	 Dome-shaped ice 

mass 
•	 Approximately 

radial ice flow 
•	 Upstanding ice mass 

over bedrock 
•	 Not to be 

interpreted as 
“mountain ice cap” 

Dome-shaped ice 
mass with radial 
flow 

•	 May incorporate ice 
domes 

•	 Longitudinal profile 
is in almost all cases 
“even/regular” (= 1). 

Excluded classification 
combinations:

–	 not classifiable in 
“Form” at all 

–	 Therefore, it is set 
at “0” 

–	 Hanging 
–	 Interrupted 

Figure 7 – Ice cap 

Figure 8 – Ice cap – Uncertain or 
miscellaneous – Lobed – Even, regular 
– Snow 

3 

Outlet glacier •	 Flows down from an 
ice sheet, ice field, 
or ice cap beyond 
its margins

•	 No clearly defined 
catchment area 

•	 Usually follows 
local topographic 
depressions 

Drains an ice sheet, 
ice field, or ice cap, 
usually of valley 
glacier form; the 
catchment area 
may not be clearly 
delineated. 

•	 The source ice sheet, 
ice field, or ice cap 
has the function of a 
“parent ice mass” in 
GLIMS. 

Excluded classification 
combinations: 

–	 Cirque 
–	 Niche 
–	 Crater 
–	 Apron 
–	 Group 

Figure 9 – Outlet glacier – Compound 
basin – Calving and expanded – 
Cascading – Snow 

Figure 10 – Outlet glacier 

4 

Cont...

Table 6.3 cont...
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Valley glacier •	 Accumulation area 
is clearly defined 
and limited by the 
topography 

•	 Ice-free slopes 
normally overlook 
glacier surface 

•	 Follows a 
preexisting valley 

Flows down 
a valley; the 
catchment area is 
well defined. 

Excluded classification 
combinations: 

–	 Cirque 
–	 Niche 
–	 Apron 
–	 Group 

Figure 11 – Valley glacier – Comp. 
basin – Normal – Cascading – Snow 

Figure 12 – Valley glacier 

5 

Mountain 
glacier 

•	 Glaciers adhering 
to mountain sides, 
and fitting in no 
other primary 
classification 
pattern, e.g., 
Cirque-, Niche-, 
and Crater-Glaciers, 
as well as Groups, 
Aprons, and 
Hanging glaciers 
and Glaciated flanks 

Cirque, Niche 
or Crater type, 
Hanging glacier; 
includes Ice apron 
and groups of small 
units (WGMS 1970) 

Any shape; 
sometimes similar 
to a valley glacier, 
but much smaller; 
frequently located 
in Cirque or Niche 
(WGMS 1977) 

Cirque, Niche 
or Crater type, 
Hanging glacier; 
includes Ice apron 
and groups of small 
units (WGMS 1998) 

•	 Must be 
distinguished from 
Valley glaciers where 
no valley has yet 
developed (often 
difficult to estimate 
from above ground) 

Excluded classification 
combinations: 

–	 Compound basins 
Figure 13 – Mountain glacier – Single 
basin – Calving – Cascading – Snow 

 Figure 14 – Mountain glacier 

6 

Glacieret and 
snowfield 

•	 Very small ice or 
snow masses 

•	 Virtually no ice 
movement 

•	 Accumulation and 
ablation area not 
always clearly 
detectable 

Small ice masses of 
indefinite shape in 
hollows, river beds, 
and on protected 
slopes, which 
have developed 
from snow drifting, 
avalanching, and/
or especially heavy 
accumulation in 
certain years; 
usually no marked 
flow pattern is 
visible; exist 
for at least two 
consecutive years 

•	 Hard to detect by 
remote sensing 
analysis, due to 
size and short-term 
changes in the 
appearance 

Excluded classification 
combinations: 

–	 Compound basins 
–	 Piedmont 
–	 Expanded 
–	 Lobed 

Figure 15 – Glacieret 

7 

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations

Definition WGMS Comments Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
– Frontal Characteristics – Longitudinal 
Profile - Major source of nourishment)

GLIMS 
code

Cont...

Table 6.3 cont...
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Ice shelf •	 Floating ice masses 
•	 Attached to the 

coast 
•	 Seaward extension 

of terrestrial 
glaciers beyond the 
grounding line 

•	 Nourished by snow 
accumulation and 
bottom freezing, in 
addition to influx of 
glacier ice 

•	 The floating part 
is not affected by 
the dynamics of the 
nourishing glaciers. 

Floating ice sheet 
of considerable 
thickness attached 
to a coast nourished 
by glacier(s); snow 
accumulation on its 
surface or bottom 
freezing 

•	 Generic development 
of an Ice shelf starts 
with the confluence 
of several floating 
glaciers. Therefore, 
this classification 
combination should 
first be taken into 
account, before 
classifying an ice 
mass as Ice shelf. 

Excluded classification 
combinations: 

–	 Is not classifiable 
in “Form” 

–	 Longitudinal profile 
is always even/
regular 

Figure 16 – Ice shelf – Uncertain or 
miscellaneous – Floating – Even – 
Snow ( MODIS ) 

Figure 17 – Ice shelf 

8 

Rock glacier • 	Lava stream-
like debris mass 
containing interstitial 
ice 

• 	Movement is 
primarily due to 
debris mass under 
the influence of 
gravity, and not due 
to ice flow patterns 

• 	Not a Debris-
covered glacier, 
but permafrost 
phenomenon 

A glacier-shaped 
mass of angular 
rock in a cirque 
or valley either 
with interstitial ice, 
firn, and snow 
or covering the 
remnants of a 
glacier, moving 
slowly downslope. 
(WGMS 1970) 

A glacier-shaped 
mass of angular 
rock in a cirque 
or valley either 
with interstitial ice, 
firn, and snow 
or covering the 
remnants of a 
glacier, moving 
slowly downslope. 
If in doubt about 
the ice content, the 
frequently present 
surface firn field 
should be classified 
as “Glacieret and 
snowfield”. (WGMS 
1977) 

Lava stream-
like debris mass 
containing ice in 
several possible 
forms and moving 
slowly downslope 
(WGMS 1998)

•	 A Debris-covered 
glacier is not 
necessarily a Rock 
glacier. To distinguish 
between Rock 
glaciers and Debris-
covered glaciers, 
the parametre group 
“Debris coverage of 
tongue” is offered. 

Excluded classification 
combinations: 

–	 Compound basins 
–	 Aprons 

Figure 18 – Rock glacier – remnant – 
normal – even – uncertain

9 

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations

Definition WGMS Comments Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
– Frontal Characteristics – Longitudinal 
Profile - Major source of nourishment)

GLIMS 
code

Table 6.3 cont...
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Ice stream •	 Part of an Ice sheet 
•	 Ice flow of higher 

velocity than 
surrounding ice 
masses 

•	 Unrestricted by 
topographic 
features, which 
protrude out of the 
ice mass 

The Primary 
Classification should be 
extended by the class 
“Ice stream” because 
they play an important 
role in the drainage of 
the Antarctic ice sheet. 
Although variable 
in time and space, 
they are well defined 
glaciological features 
and are of high 
importance for draining 
the continental ice 
sheets. 

10 

Digit 2: Form 
The parametre group “Form” essentially describes the outline of a glacier (Table 6.4). Most categories also 
correspond to the catchment area and therefore give important information on the extent and shape of a glacier. 
To get an impression of the whole accumulation basin, a DEM is very helpful in facilitating automatic delineation 
of glacier catchment areas. Because a precise DEM is not available for all regions, the outline can often be 
estimated only by optical means and has to be delineated by hand. The classification of “Form” should in most 
cases be possible, even though several ice masses are already described through the Primary Classification. As a 
consequence, these glaciers no longer have to be classified in “Form” and are set “0” (this includes, for example, 
“Ice shelf” and “Ice cap” or in some cases “Ice fields” and “Mountain glaciers”). 

Table 6.4:  Forms

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations 

Definition WGMS Comment Satellite Image / Photo / Graphics 

(if present: Primary classification - Form 
- Frontal Characteristics - Longitudinal 
Profile - Major source of nourishment) 

GLIMS 
Code

Uncertain or 
miscellaneous 

•	 Any type not listed 
below 

Any type not listed 
below 

0 

Compound 
basins 

•	 Dendritic system 
of Outlet or 
Valley glaciers of 
more than one 
“compound basin” 
that merge together 

Two or more 
individual Valley 
glaciers issuing from 
tributary valleys and 
coalescing 

Figure 19 – Compound basins

Figure 20 – Outlet glacier - 
Compound basins – Normal – 
Cascading – Snow 

1 

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations

Definition WGMS Comments Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
– Frontal Characteristics – Longitudinal 
Profile - Major source of nourishment)

GLIMS 
code

Cont...

Table 6.3 cont...
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Compound 
basin 

•	 Several catchment 
areas of a simple 
basin type (see 
below) in a 
specific zone of 
accumulation 
feeding a glacier 
tongue 

Two or more 
individual 
accumulation basins 
feeding one glacier 
system 

•	 Can be used if a 
mountain glacier 
consists of several 
cirques, but has no 
valley developed 

Figure 21 – Compound basin 

Figure 22 – Outlet glacier – 
Compound basin – Calving -- 
Interrupted – Avalanche 

2 

Simple basin •	 Glacier is fed from 
one single basin 

•	 Catchment area is 
detectable 

•	 Defined and limited 
by underlying or 
surface topographic 
features 

•	 Develops a glacier 
tongue out of one 
basin 

Single accumulation 
area 

•	 Does not need to be 
located in a valley 
(Mountain glacier) 

Figure 23 – Simple basin 

Figure 24 – Outlet glacier – Simple 
basin – Calving – Even – Snow 

3 

Cirque •	 Located in an 
armchair-shaped 
bedrock hollow 

•	 No tongue 
developed, in 
contrast to simple 
basin 

•	 As wide as, or even 
wider than, their 
length 

•	 Catchment area is 
created through the 
process of glacial 
erosion 

Occupies a separate, 
rounded, steep-
walled recess which 
it has formed on a 
mountainside 

Excluded classification 
combinations: 

–	 Piedmont 

Figure 25 – Cirque

Table 6.4 cont...

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations 

Definition WGMS Comment Satellite Image / Photo / Graphics 

(if present: Primary classification - Form 
- Frontal Characteristics - Longitudinal 
Profile - Major source of nourishment) 

GLIMS 
code

Cont...
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Figure 26 – Mountain glacier – 
Cirque – Normal – Even – Snow 

Figure 27 – Cirque 

4 

Niche •	 Small glaciers in 
v-shaped couloirs or 
depressions 

•	 Adhering to a 
mountain slope 

•	 genetically less 
developed in form 
than Cirque glacier 

Small glacier in 
V-shaped gully or 
depression on a 
mountain slope; 
generally more 
common than the 
genetically further 
developed Cirque 
glacier (WGMS 
1970, 1998) 

Small glacier in 
V-shaped gully or 
depression on a 
mountain slope 
(WGMS 1977) 

Excluded classification 
combinations: 

–	 Piedmont 
–	 Expanded 

Figure 28 – Niche 

5 

Crater •	 Glaciers in and/or 
on volcano craters 

•	 Network of glaciers 
encompassing 
the summit at the 
outward flanks 

Occurring in extinct 
or dormant volcanic 
craters, which rise 
above the regional 
snow line (WGMS 
1970)

Occurring in and/or 
on volcanic craters 
(WGMS 1977)
 
Occurring in extinct 
or dormant volcanic 
craters (WGMS 
1998) 

Figure 29 – Crater (Photo: Peter 
Knight) 

Figure 30 – Mountain glacier – Crater 
– Normal – Even – Snow 

6 

Table 6.4 cont...

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations 

Definition WGMS Comment Satellite Image / Photo / Graphics 

(if present: Primary classification - Form 
- Frontal Characteristics - Longitudinal 
Profile - Major source of nourishment) 

GLIMS 
code

Cont...
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Ice apron •	 Steep, ice-covered 
mountain faces 

•	 Hanging glaciers 
•	 Thin ice flanks
•	 See longitudinal 

characteristics for 
further differentiation 

Irregular, usually 
thin, ice mass 
which adheres to a 
mountain slope or 
ridge 

•	 Includes ice fringes 
•	 Thin ice and snow-

overed mountain 
flank (ice flanks or 
steep “ice fields”) 

Excluded classification 
combinations: 

–	 Piedmont 
–	 Expanded 
–	 Cascading 

Figure 31 – Ice apron 

Figure 32 – Ice apron 

7 

Group •	 Neighboring small 
glaciers 

•	 Slightly connected 
but too small to be 
treated separately 

A number of similar 
small ice masses 
occurring in close 
proximity and too 
small to be assessed 
individually 

8 

Remnant •	 Disconnected from 
accumulation area 

•	 Inactive 

An inactive, usually 
small ice mass left by 
a receding 
glacier 

Excluded classification 
combinations: 

–	 In “Dominant 
mass source” not 
classifiable 

9 

Digit 3: Frontal Characteristics
To make the frontal characteristic classification more precise, GLIMS proposed modifications to the WGMS system 
(Table 6.5). Several studies have shown the need for changing and expanding the classification values according 
to the various glacier fronts appearing all over the world (e.g., Weidick et al., 1992). The proposed changes in 
classification were kept to a minimum in order to maintain the compatibility with the WGMS database. Where the 
WGMS definitions correspond with the GLIMS definitions, they are listed in the “Definition WGMS” column. If there 
is no entry in the “Definition WGMS” column, GLIMS has redefined the value or added a totally new one. 

Further explanations: 

Terrestrial glaciers:	 glaciers which rest their entire extent on bedrock and do not have any contact with the sea 

Grounded glaciers: 	 glaciers which rest on bedrock to a large extent but which may have parts reaching into lake 
or sea water (tidewater glaciers) 

Floating glaciers: 	 tidewater glaciers with floating tongues. Their lateral margins might be attached to the 
coastline; where there is no more topographic limitation, it might expand. 

Table 6.4 cont...

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations 

Definition WGMS Comment Satellite Image / Photo / Graphics 

(if present: Primary classification - Form 
- Frontal Characteristics - Longitudinal 
Profile - Major source of nourishment) 

GLIMS 
code
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Normal or 
miscellaneous

 •	The entire width of 
the tongue terminates 
on dry ground 

•	 Irregular or single 
lobe frontal line

Normal or 
miscellaneous

Figure 33 – Outlet glacier – Simple 
basin – Normal – Cascading – Snow 

Figure 34 – Normal; example of 
normal frontal characteristic with 
irregular tongue 

Figure 35 – Normal; example of 
normal frontal characteristic with single-
lobed tongue 

Figure 36 – Normal, “single lobe” 

0 

Piedmont • Occurs in 
unconstrained 
topographic areas 
(lowland) 

• Expanding glacial 
fronts 

• Radial frontal shape 
• “Terrestrial glaciers” 
• If it terminates into 

sea, use class 
“calving and 
piedmont” 

Ice field formed 
on a lowland by 
lateral expansion 
of one glacier or 
coalescence of 
several glaciers

Figure 37 – Piedmont

1

Table 6.5:  Frontal characteristics

Name GLIMS glacier parametre 
identification checklist 
for remote sensing 
observations

Definition WGMS Comment Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
- Frontal Characteristics – Longitudinal 
Profile
– Major source of nourishment)

GLIMS 
code

Cont...
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Figure 38 – Piedmont 

Figure 39 – Outlet glacier – Compound 
basin – Piedmont – Cascading – Snow 

Figure 40 – Piedmont 

1 

Expanded •	 Frontal expansion on 
a level surface (not 
necessary lowland) 

•	 Less restricted by 
topography 

•	 Widening of the 
tongue (lateral 
expansion is less than 
for Piedmont) 

•	 “Terrestrial glaciers” 
•	 If it terminates 

into sea, use class 
“calving and 
expanded” 

Lobe or fan formed 
where the lower 
portion of the 
glacier leaves the 
confining wall of a 
valley and extends 
to a less restricted 
and more level 
surface (WGMS 
1970, 1998)

Lobe or fan formed 
where the lower 
portion of the 
glacier leaves the 
confining wall of a 
valley and extends 
to a less restricted 
and more level 
surface. Lateral 
extension markedly 
less than for 
Piedmont. (WGMS 
1977) 

Figure 41 – Expanded 

 

Figure 42 – Expanded 

2 

Table 6.5 cont...

Name GLIMS glacier parametre 
identification checklist 
for remote sensing 
observations

Definition WGMS Comment Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
- Frontal Characteristics – Longitudinal 
Profile
– Major source of nourishment)

GLIMS 
code

Cont...
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Lobed • Initial stage of tongue 
formation (occurs 
on both micro and 
macro scales) 

• In many cases, part 
of an ice sheet, cap, 
or field 

• Large or small scale 
radial ice margin 

• Is not an outlet or a 
Valley glacier 

• “Terrestrial glaciers” 
• If it terminates into 

sea, use class 
“calving and lobed”

Part of an ice 
sheet or ice cap, 
disqualified as 
an outlet glacier 
(WGMS 1970, 
1998) 

Tongue-like form of 
an ice field or ice 
cap (WGMS 1977) 

Figure 43 – Lobed 

Figure 44 – Ice cap – 
Uncertain – Lobed – Even – Snow 

3 

Calving •	 Terminus extends 
into lake or sea 
(Tidewater glacier) 

•	 Produces icebergs 
•	 Any glacier that 

possesses “Normal” 
frontal characteristics 
and is calving 

•	 Not to be used for 
“Terrestrial calving” 
(“dry calving”) 

Terminus of a 
glacier sufficiently 
extending into sea 
or lake water to 
produce icebergs; 
includes – for this 
inventory – dry 
land calving 
which would be 
recognisable from 
the “lowest glacier 
elevation” (WGMS 
1970, 1998) 

Terminus of a 
glacier sufficiently 
extending into sea 
or occasionally lake 
water to produce 
icebergs; includes 
– for this inventory 
– dry land calving 
(WGMS 1977) 

If the frontal terminus 
is calving on dry land 
see classification for 
“Terrestrial calving” 

Figure 45 – Outlet glacier – Compound 
basin – Calving – Even – Snow 

Figure 46 – Calving

4

Coalescing, 
non-contributing 

•	 Glaciers whose 
tongues come 
together and flow 
in parallel without 
coalescing 

•	 No merging of ice 
masses 

See Figure 47 
(WGMS 1970, 
1998) 

Glaciers whose 
tongues come 
together and flow 
in parallel without 
coalescing (WGMS 
1977) 

Figure 47 – Coalescing, non-
contributing 

5 

Cont...

Table 6.5 cont...

Name GLIMS glacier parametre 
identification checklist 
for remote sensing 
observations

Definition WGMS Comment Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
- Frontal Characteristics – Longitudinal 
Profile
– Major source of nourishment)

GLIMS 
code
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Calving and 
Piedmont 

•	 Combination 
of Calving and 
Piedmont 

Figure 48 – Outlet glacier – 
Compound basins – 
Calving and Piedmont – 
Even – Snow 

10 

Calving and 
Expanded 

•	 Combination 
of Calving and 
Expanded 

Figure 49 – Outlet glacier – Compound 
basins – Calving and Expanded – 
Cascading – Snow 

11 

Calving and 
Lobed 

•	 Combination of 
Calving and Lobed 

•	 “Grounded glaciers” 

Figure 50 – Ice cap – 
Uncertain – Calving and lobed – Even 
– Snow 

12 

Ice shelf 
nourishing 

•	 Glaciers which are 
tributaries of an ice 
shelf 

•	 Approximate 
grounding line may 
be detectable 

•	 This class has been 
introduced due 
to the necessity 
for classifying 
glaciers which are 
tributaries of an 
ice shelf. 

Figure 51 – Outlet glacier – Simple 
basin – Ice Shelf nourishing – 
Cascading – Snow 

13 

Cont...

Table 6.5 cont...

Name GLIMS glacier parametre 
identification checklist 
for remote sensing 
observations

Definition WGMS Comment Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
- Frontal Characteristics – Longitudinal 
Profile
– Major source of nourishment)

GLIMS 
code
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Floating •	 Glacier terminus is 
floating in the sea 

•	 Approximate 
grounding line may 
be detectable 

•	 Tidewater glacier 
•	 Implies that the 

glacier is calving 

Figure 52 – Outlet glacier – Compound 
basin – Floating – Cascading – Snow 

14 

Figure 53 – Floating 
Terrestrial 
calving 

•	 Dry calving 
•	 Ice front breaks off 

over cliffs or rock 
steps of different 
height 

•	 This class has 
been introduced 
to facilitate a 
differentiation 
between calving 
into water (lakes, 
sea) and dry 
calving. 

Figure 54 – Terrestrial calving 

Figure 55 – Terrestrial calving 

15 

Confluent •	 Tributary glacier 
tongues that merge 
into other glaciers 

•	 Merging ice masses 

Figure 56 – <1> Outlet glacier 
– Compound basins – Normal– 
Cascading – Snow 
<2> Valley glacier – 
Compound basin – Confluent – 
Cascading – Snow 

16 

Table 6.5 cont...

Name GLIMS glacier parametre 
identification checklist 
for remote sensing 
observations

Definition WGMS Comment Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
- Frontal Characteristics – Longitudinal 
Profile
– Major source of nourishment)

GLIMS 
code



39

6. Glacier Inventory Methodology

Digit 4: Longitudinal Characteristics 
The Longitudinal characteristic encodes the description of the surface profile of a glacier (Table 6.6). 

Table 6.6:  Longitudinal characteristics

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations 

Definition WGMS Comment Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
- Frontal Characteristics – Longitudinal 
Profile - Major source of nourishment) 

GLIMS 
code

Uncertain or 
miscellaneous 

•	 Uncertain or 
miscellaneous 

Uncertain or 
miscellaneous 

0 

Even, regular •	 Regular 
•	 No striking changes 

in glacier surface 
profile 

•	 No crevasses 
•	 Can form on vertical 

slopes 

Includes the regular 
or slightly irregular 
and stepped 
longitudinal profile 
(Not included in 
WGMS 1995) 

Figure 57 – Even

Figure 58 – Even

Figure 59 – Ice field – Uncertain 
or miscellaneous – Uncertain or 
miscellaneous – Even, regular – Snow 

1 

Figure 60 – Even 

Cont...



40

Training Manual on Application of RS and GIS for Mapping and Monitoring of Glaciers: Part I – Glacier Mapping using eCognition

Hanging •	 Hanging only 
•	 No connection with 

mountain foot
•	 Up to 60° slope 

Perched on a steep 
mountain-side or 
issuing from a 
hanging valley 
(WGMS 1970) 
Perched on a steep 
mountain-side or 
issuing from a steep 
hanging valley 
(WGMS 1977) 
(Not included in 
WGMS 1995) 

Figure 61 – Hanging 

Figure 62 – Hanging 

2 

Cascading •	 Changes in the 
inclination of the 
glacier surface 

•	 Areas of crevasses 
and seracs are 
common 

Descending in a 
series of marked 
steps with some 
crevasses and 
seracs. (Not 
included in WGMS 
1995) Figure 63 – Cascading 

Figure 64 – Cascading 

Figure 65 – Outlet glacier – 
Compound basin – Calving 
– Cascading – Snow 

3 

Table 6.6 cont...

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations 

Definition WGMS Comment Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
- Frontal Characteristics – Longitudinal 
Profile - Major source of nourishment) 

GLIMS 
code

Cont...
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Ice-fall •	 Closed ice cover 
over a steep 
mountainside 

•	 Entirely crevassed 
with many seracs 

Break above a cliff, 
with reconstitution 
to a cohering ice 
mass below (WGMS 
1970) 
A glacier with a 
considerable drop 
in the longitudinal 
profile at one point, 
causing heavily 
broken surface 
(WGMS 1977) 
(Not included in 
WGMS 1995) 

• In this field the 
GLIMS Checklist 
definition differs 
from WGMS. 
What WGMS 
means is greatly 
covered by GLIMS 
field interrupted. 
Due to the 
proposed GLIMS 
definition, a 
distinction between 
these two fields 
should be made 
easier. 

Figure 66 – Ice-fall 

Figure 67 – Ice-fall 

Figure 68 – Ice-fall 

4 

Interrupted •	 Glacier flow is 
interrupted by very 
steep cliff(s) 

•	 No dynamic 
connection 

•	 Reconstruct below 
the cliff 

Not defined in 
(WGMS 1970) 

Glacier that breaks 
off over a cliff and 
reconstitutes below 
(WGMS 1977) 

Not included in 
(WGMS 1995) 

•	 The entire 
catchment area 
of the glacier has 
to be looked at in 
order to identify 
if a glacier is 
interrupted or not. Figure 69 – Interrupted 

Figure 70 – Outlet glacier – 
Compound basin – Calving -- 
Interrupted – Avalanche 

Figure 71 – Interrupted 

5 

Table 6.6 cont...

Name GLIMS glacier 
parametre identification 
checklist for remote 
sensing observations 

Definition WGMS Comment Satellite Image/Photo/Graphics (if 
present: Primary classification – Form 
- Frontal Characteristics – Longitudinal 
Profile - Major source of nourishment) 

GLIMS 
code



42

Training Manual on Application of RS and GIS for Mapping and Monitoring of Glaciers: Part I – Glacier Mapping using eCognition

Digit 5: Major Source of Nourishment 
The dominant mass sources are not easy to detect. Often it is only possible to classify a glacier based on its major 
source of nourishment on a “best guess” decision. 

Table 6.7:  Major source of nourishment

Name GLIMS glacier parametre 
identification checklist 
for remote sensing 
observations 

Definition WGMS Comment Satellite Image/Photo/Graphics (if 
present: Primary 

classification - Form - Frontal 
Characteristics - Longitudinal Profile - 
Major source of nourishment) 

Codes

Unknown •	 Unknown Unknown 0 

Snow / Drift 
snow 

•	 Snow 
•	 Wind transported 

snow and 
accumulation in lee 
sides 

•	 Hoar 

Snow and/or drift 
snow 

Figure 72 – Drift snow 

1 

Avalanches •	 Snow avalanches 
•	 Ice avalanches 

Avalanche ice and/or 
avalanche snow 

Figure 73 – Outlet glacier – 
Compound basin – Calving -- 
Interrupted – Avalanches 

2 

Super-imposed 
ice 

•	 Superimposed ice Superimposed ice 3 
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Table 6.8:  Tongue activity

Name GLIMS glacier parametre identification 
checklist for remote sensing observations 

Definition WGMS Comment Code 

Uncertain •	Uncertain, unknown, or not 
measured 

Uncertain 0

Marked retreat •	 Marked retreat More than 20m per year 
retreat 

1

Slight retreat •	 Slight retreat 20m per year retreat 2

Stationary •	 Stationary Stationary 3

Slight advance •	 Slight advance 20m per year advance 4

Marked 
advance 

•	 Marked advance More than 20m per year 
advance 

5

Possible surge •	 Possible surge Possible surge 6

Known surge •	Known surge Known surge 7

Oscillating •	 Oscillating Oscillating 8

Downwasting •	 Downwasting - stationary but rapidly 
losing mass through 
melting 

9

Digit 6: Tongue Activity 
The classification of the tongue activity is affected by uncertainties in accuracy of the analyzed imagery (spatial 
resolution, geodetic accuracy, displacement errors, etc.) and data availability. In fact, the estimation of the extent of 
glacier change depends on the glacier size, as well as on the glacier type. Therefore, the suggested WGMS rates 
indicate the extent of change is only subjective (Table 6.8). The proposed rates should be regarded as a rough 
estimation, as, for example, a 20m recession of a glacieret of 150m length will be classified as a marked retreat, 
whereas, in contrast, a 30m retreat of an outlet glacier would be considered only as a slight retreat. 



44

Training Manual on Application of RS and GIS for Mapping and Monitoring of Glaciers: Part I – Glacier Mapping using eCognition

7.		Hands-on Exercises 

7.1	 Hands-on Exercise I: Getting Started with eCognition Developer 8
Definiens eCognition Developer is a powerful integrated development environment for rapid image analysis 
solution development. Developers have unlimited access to the full functionality of the Definiens Cognition Network 
Language, along with development and workflow tools to aid in the rapid development of new image analysis 
solutions.

To start the Definiens eCognition Developer, click the Windows Start menus and 
go to Programs, then to eCognition Developer Trial and click on 

.

The Definiens eCognition Developer launching dialog box is opened.

Now select the Rule Set Mode function in the launching dialog box and click on .

Then the Definiens eCognition Developer window is opened and it contains following features:

zz Menu bar, Toolbars, and Status bar
zz Map or Project View
zz Process Tree, Class Hierarchy, Image Object Information, and Feature View

The view of the main window is shown in the figure below.
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You can add additional windows to your layout and hide them again if you do not need them. Normally, additional 
windows find their place in the default layout. You can drag them to the desired position and size.

You can choose between different workflow views, which are preset layouts of the user interface. A workflow view 
displays all required windows for each of the major workflow steps.

a)	 Menu Bar
The menu bar is in the top row of the main window. It contains File, View, Image Object, Analysis, Library, 
Classification, Process, Tools, Export, Window, and Help options. Each option in the menu bar contains a drop-
down menu. These menus are described below.

zz Click on the File menu at the upper left corner of the eCognition Developer menu bar. 
The File drop-down menu opens, which contains the following sub-menus:

zz Click on the View menu on the right side of the File menu in the menu bar. The View 
drop-down menu opens, which contains the following sub-menus:

zz Click on the Image Objects menu on the right side 
of the View menu in the menu bar. The Image 
Objects drop-down menu opens, which contains the 
following sub-menus:
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zz Click on the Analysis menu on the right side of the Image Objects menu in the 
menu bar. The Analysis drop-down menu opens, which contains the following 
sub-menus:

zz Click on the Library menu on the right side of the Analysis menu in the menu 
bar. The Library drop-down menu opens, which contains the following sub-
menus:

zz Click on the Classification menu on the right side of the Library menu in the 
menu bar. The Classification drop-down menu opens, which contains the 
following sub-menus:

zz Click on the Process menu on the right side of the Classification menu in 
the menu bar. The Process drop-down menu opens, which contains the 
following sub-menus:
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zz Click on the Tools menu on the right side of the Process menu in the 
menu bar. The Tools drop-down menu opens, which contains the 
following sub-menus:

zz Click on the Export menu on the right side of the Tools menu in the 
menu bar. The Export drop-down menu opens, which contains the 
following sub-menus:

zz Click on the Window menu on the right side of the Export menu in the menu bar. The 
Window drop-down menu opens, which contains the following sub-menus:

Windows like Image Object Information facilitate the image analysis. They provide 
functions or controls for viewing and working with images.

They can be opened using the appropriate menu items or by clicking the respective 
icons in the toolbars. Changes or selections in the windows are automatically shown 
in the project view. Windows can be moved to almost any position on your screen.

zz Click on the Help menu on the right side of the Window menu in the 
menu bar. The Help drop-down menu opens, which contains the 
following sub-menus:

b)	 Toolbar
Toolbars contain buttons or list boxes to help you view or analyze your 
images. To check and modify the displayed toolbars, select View > 
Toolbars in the main menu bar. Alternatively, you can go to the Toolbars tab 
of the Customize dialog box. 

Toolbars may be docked at the edges of the main window. Also, they may be undocked as floating toolbars. 
Holding Ctrl while dragging deactivates the magnetic snapping, allowing you to place the toolbars anywhere on 
your screen. Right-clicking anywhere inside the menu bar and toolbar area allows you to access a context menu, 
which provides a selection of the View menu options.
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According to the functionality of various tools in the Tool Bar menu in the main window, they are grouped into File, 
View Setting, Zoom Function, View Navigate, and Tools. The Tools icons and their functionalities are described 
below.

File Toolbar
The File toolbar allows loading image files, opening projects, saving projects, creating new workspaces, and 
importing predefined workspaces.

View Setting Toolbar

The first four buttons in group 1  , numbered from one to four, allow switching between the four window layouts. 
These four tools are Load and Manage Data, Configure Analysis, Review Results, and Develop Rule Sets.

The buttons in group 2  allow you to select image view options, offering views of layers, classifications, samples, 
and any features you wish to visualize.

The buttons in group 3  are concerned with displaying outlines and borders of image objects and with views of 
pixels.

The buttons in group 4  allow you to visualize different layers in grayscale or in RGB. They also allow you to switch 
between layers and to mix them.

Zoom Toolbar

This toolbar offers direct selection and the ability to drag an image, along with several zoom options.

View Navigate Toolbar

This toolbar allows deleting levels , selecting maps , and navigating the object  
hierarchy .

Tools Toolbar

The buttons on the Tools toolbar launch the following dialog boxes and toolbars:

Image Object Information 

Image Object Table 

Redo and Undo Process Editing  

1 2 3 4



49

7. Hands-on Exercises

Class Hierarchy 

Process Tree 

Feature View 

Manage Customize Features 

Manual Editing Toolbar 

c)	 Creating a New Project
When creating a project, you import image layers and optionally thematic layers into a new project. You can 
rearrange the image layers, select a subset of the image, or modify the project default settings. In addition, you can 
add metadata.

An image file contains one or more image layers. For example, an RGB image file contains three image layers, 
which are displayed through the Red, Green, and Blue channels (layers).

zz To Create a new project, go to the File menu in the menu bar and click on the New Project sub-menu in the 
dropdown File menu or directly click on Create New Project   button on the File Toolbar. 

zz Then the Create Project and Import Image Layers window is opened.

Now go to the location of the data. To locate the data:

zz Click on the home icon on top of the Import Image layers window.
zz Select the drive and folder location (“C:\TrainingData\Glacier_mapping”) from the list in the box at the top left 

corner of the window just below the home icon.
zz Select the files “Langtang_2009_clip.img”, “Dem.img”, and “Slope.img” in the file list box at the right side of 

the window.
zz Click the “OK” button to add data.
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To open some specific file formats or structures, you 
have to proceed as follows:

zz First, select the correct driver in the Files type drop-
down list box, or you can type “*.img” in the File 
Name Filter text box to view the “img” files.

zz Then, select from the main file in the files list 
window.

The Create Project window has four Main sections.

General Settings
zz The geocoding information is displayed if the “Use 

geocoding” check box is selected.
zz The resolution is automatically detected and displayed in the “Resolution” field.
zz The unit is detected automatically if auto is selected from the drop-down list.
zz The unit is automatically set to metres, but can be changed by selecting another one from the drop-down list.

Image Layers

zz All preloaded image layers are displayed, along with their properties. To select an image layer, click it. To select 
multiple image layers, press Ctrl or the Shift key and click on the image layers.

zz To edit a layer, double-click or right-click an image layer and choose “Edit”. The “Layer Properties” dialog box 
will open. Alternatively, you can click the “Edit” button.

zz To insert an additional image layer, you can click the “Insert” button or right-click inside the image layer display 
window and choose “Insert” on the context menu.

zz To remove one or more image layers, select the desired layer(s) and click “Remove”.

General setting

Image layers

Thematic layers

Metadata

1
2
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zz To change the order of the layers, select an image layer and use the up and down arrows.
zz To set No Data values for those pixels not to be analyzed, click “No Data”. The ”Assign No Data Values” dialog 

box opens.

Thematic Layers
zz To insert a thematic layer, you can click the “Insert” button or right-click inside the thematic layer display window 

and choose “Insert” from the context menu.
zz To edit, insert additional layer, and Remove a thematic layer, follow the instructions for editing image layers 

described above.

Metadata
zz Can add, remove, edit, and preview additional information data as an .ini file, if available.

d)	 Subset Selection
To open the Subset Selection dialog box, do the following:

zz After importing image layers, press the Subset Selection 2  button. 
The Subset Selection dialog box is opened. 

zz In the Subset Selection Dialog box, Click in the image and drag it 
to select a subset area. 

zz Alternatively, you may enter the subset coordinates. You can modify 
the coordinates by typing.

zz Confirm with OK to return to the super ordinate dialog box.
zz You can clear the subset selection by clicking Clear Subset in the 

super ordinate dialog box.

e)	 Define Layer Aliases
In order to generate Rule Sets that are transferable between different 
datasets, the loaded channels or layers of image have to have aliases 
assigned to them.

zz To assign a layer alias, select the layer in the “Create Project” 
dialog box and double-click it.

zz Then the Layer Properties dialog box is opened. Assign for Layer 
1 as “Band 1” in the Layer Alias section in the Layer Properties 
dialog box.

zz Confirm the alias with “OK”.
zz Assign the following aliases to the other layers:

Layer 2  Band 2

Layer 3  Band 3

Layer 4  Band 4

Layer 5  Band 5, and so on

f)	 Displaying Image Layers



52

Training Manual on Application of RS and GIS for Mapping and Monitoring of Glaciers: Part I – Glacier Mapping using eCognition

For better visualization of the image and to recognize the visual structures without actually changing them, the color 
composition of image layers can be defined to display in the map view. In addition, the different equalizing options 
can be chosen for better visualization.

While creating a new Project, the first three image layers are displayed in red, green, and blue; to change the layer 
mixing, open the Edit Image Layer Mixing dialog box.

zz To open the layer mixing dialog box, go to View in the menu bar and select or click on the Image Layer Mixing 
from the drop-down menu, OR directly click on the Image Layer Mixing button  from the View Setting Toolbar.

			 

zz Click on the dots for the red, green, and blue layers to deactivate the default image layer view. Click on the 
red, green, and blue column of the respective image layer which you want to view in the respective channels 
to activate the image layers. Also, for better visualization, you can change the Equalizing function to None, 
Linear, Standard Deviation, Gamma Correction, 
Histogram, and Manual.

zz At the bottom of the “Edit Layer Mixing” dialog 
box, click “OK”. 

g)	 Save a Project
Save the currently open project to a project file 
(extension .dpr). To save a project, do the following:

Choose File > Save Project on the main menu bar.

zz Choose File > Save Project As on the main menu 
bar. The Save Project dialog box opens. Select a 
folder and enter a name for the project file (.dpr). 

zz Click the Save button to store the file.

h)	 Modify Project
Modify a selected project by exchanging or renaming image layers or through 
other operations.

To modify a project, do the following:

zz Open a project and choose File > Modify Open Project on the main menu 
bar.

zz The Modify Project dialog box opens.
zz Modify as necessary.
zz Click OK to modify the project.

i)	 Creating Image Objects Through Segmentation
The fundamental step of eCognition image analysis is to divide the image into defined areas or into image object 
primitives. This is called segmentation and creates undefined objects. Thus, initial segmentation is the subdivision of 
an image into separated regions represented by basic unclassified image objects called image object primitives. By 
definition, these objects will be relatively crude, but we can refine them later on with further rule sets. It is preferable 
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to create fairly large objects, as smaller numbers are 
easier to work with.

For successful image analysis, defining object 
primitives of suitable size and shape is of utmost 
importance. As a rule of thumb, good object primitives 
are as large as possible, yet small enough to be used 
as building blocks for the objects to be detected in the 
image. Pixels are the smallest possible building block; 
however, pixels have limited information. To get larger 
building blocks, different segmentation methods are 
available to form contiguous clusters of pixels that have 
larger property space.

Commonly in image processing, segmentation is the 
subdivision of a digital image into smaller partitions 
according to given criteria. Within the eCognition 
technology, however, each operation that creates new 
image objects is called segmentation, regardless of 
whether the change is achieved by subdividing or by 
merging existing objects. 

Different segmentation algorithms provide several 
methods for creating image object primitives. The new 
image objects created by segmentation are stored in 
what is called a new image object level. Each image 
object is defined by a contiguous set of pixels, where 
each pixel belongs to exactly one image object. Each 
of the subsequent image object-related operations, 
like classification, reshaping, re-segmentation, and 
information extraction, is done within an image object 
level. Simply said, image object levels serve as 
internal working areas of the image analysis.

Chessboard Segmentation: The Chessboard 
Segmentation algorithm splits the pixel domain or an 
image object domain into square image objects. A 
square grid aligned to the image left and top borders 
of fixed size is applied to all objects in the domain 
and each object is cut along these gridlines. 

Quadtree-Based Segmentation: The Quadtree-Based 
Segmentation algorithm splits the pixel domain or an 
image object domain into a quadtree grid formed by 
square objects. The quadtree grid is built so that each 
square has a maximum possible size and fulfills the 
homogeneity criteria defined by the mode and scale 
parametres.

Multiresolution Segmentation: The Multiresolution 
Segmentation algorithm consecutively merges pixels 
or existing image objects. It is based on a pairwise 
region merging technique.

Spectral Difference Segmentation: The Spectral 

Chessboard segmentation

Quad Tree Based Segmentations

Multiresolution Segmentations
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Difference Segmentation algorithm merges neighboring image objects according to their mean image layer intensity 
values. This algorithm is designed to refine existing segmentation results, by merging spectrally similar image objects 
produced by previous segmentation. It cannot be used to create new image object levels based on the pixel level 
domain.

To create the new object level (Image Segmentation), use the following steps:

zz Right-click in the Process Tree window and select Append New from the context menu. The Edit Process dialog 
appears. In the Name field, enter “Segmentation” and “remove background”. Press OK. In the Edit Process box, 
you have the choice to run a process immediately (by pressing Execute) or to save it to the Process Tree window 
for later execution (by pressing OK).

zz In the Process Tree window, right-click on this new rules (Segmentation) and select Insert Child. The Edit Process 
dialog box appears. In the Algorithm drop-down box of the Edit Process dialog box, select Multiresolution 
Segmentation. In the Segmentation Settings, which now appear on the right-hand side of the dialog box, change 
the Level Name to “Level 1”, Image Layer Weights as 0 for false and 1 for true, Scale Parametre, and also 
set Composition of homogeneity if necessary. 
Then Press OK to save the rule in the Process Tree 
window for later execution, or if you want to run 
the rule set, immediately press the Execute button.

zz After execution of the segmentation rule sets, it 
creates a new Image Objects Level named as 
Level 1 are stored which can be viewed in the 
View Navigation toolbar in the drop-down menu of 
the object hierarchy menu.

j)	 Deleting Image Objects Level
Deleting an image object level enables you to work 
with image object levels that are temporary, or 
that might be required for testing processes while 
developing rule sets. 

zz To delete an image objects level which is created 
temporarily for testing processes, go to the Image 
Objects menu in the menu bar in the top row of the 
Project window. Select the Delete Levels sub menu 
from the drop-down menu of Image Objects. You 
can also do this by directly clicking on the Delete 
Level  button in the View Navigation Toolbar. 
Then the Delete Level dialog box appears.
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In the Delete Level dialog box, all the image object levels are displayed according to 
the hierarchy of the image objects. To delete the image object level, select it and click 
the OK button in the dialog box to confirm that you want to remove the selected image 
object level.

k)	 Classify Image Object Level
After image objects have been created in your scenes, you need to classify them to give 
them both a meaning and a label. Information contained in image objects is used as a 
filter for classification.

zz Based on a classification of image objects, you can analyze and interpret complete 
images. To perform a classification, appropriate classes need to be defined. During classification, the image 
objects are analyzed according to defined criteria and assigned to classes that best meet the defined criteria.
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7.2 	 Hands on Exercise II: Clean-ice Glacier Mapping
If the Program is not open, go to the Windows Start menu and Click Start > Programs > eCognition Developer Trial 
8.0>   

Then Definiens eCognition Developer launching dialog box is opened. Select the Rule Set mode function in the 
launching dialog box and click on .

The Definiens eCognition Developer window will now be open.
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Create New Project for Glacier Mapping
zz To Create a New Project, go to File menu in the menu bar and click on the New Project menu in the drop-down 

File menu, or alternatively, directly click on the New Project  button in the File toolbar.
zz Then the Create Project sub-window and Import Image Layers dialog box is opened.
zz Now go to the location of the data (C:\TrainingData\Glacier_mapping) from the Look in drop-down menu in 

the top of the Import Image Layers dialogue box and select image file (‘Langtang_2009_clip.img’) and click on 
the OK button.

 

zz Double click on each Image Layer Alias and Rename all 
the Image Layers Aliases in each Image Layer Properties 
dialog box (Layer 1  Band 1; Layer 2  Band 2; Layer 
3  Band 3; Layer 4  Band 4; Layer 5  Band 5; 
Layer 6  Band 7) and confirm each renamed Layers 
alias by clicking the OK button in each Layer Properties 
dialog box. 

zz Again, add DEM and Slope Raster layers. To insert a 
DEM Layer, click on the Insert button in the Image Layer 
section of the Create Project dialog box and go to the location of the data (C:\TrainingData\Glacier_mapping) 
and open the DEM raster file (Dem.img). Similarly, add the Slope raster file (Slope.img).

zz Rename the DEM and Slope raster layer alias as Dem and Slope by double clicking the respective layers.
zz After adding all the data in the image layer section, click the OK button in the Create Project dialog box.
zz Save the Project as ‘LangtangGr_mapping.dpr’ by clicking on the Save Project button in the File toolbar, or go to 

the File menu and click on the Save Project menu.

Displaying Image Layers
The color composition of the image layers is set to display 
in map view for better visualization and to recognize the 
visual structures without actually changing them. In default 
view, the first three image layers are displayed in red, 
green, and blue. To change the display of the image 
layer for better visualization in glacier mapping, use the 
following steps:

zz Click on the Image Layer Mixing  button in the 
View Setting Toolbar or, alternatively, go to View in 
the Menu bar and click on the Image Layer Mixing in 
the drop-down View Menu. Then the Edit Image Layer 
Mixing dialog box is opened.
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zz Change the Default band combinations Band 3, Band 2, and Band 1 as Red, Green, and Blue to Band 4, Band 
3, and Band 2, or Band 5, Band 4, and Band 2 as Red, Green, and Blue. 

zz Then change Histogram in Equalizing.
zz Click on the OK button to confirm the changes in band combination. 

Creating Image Object Levels (Segmentation)

Inserting Parent Process
zz If the Process Tree window is not opened, go to the 

Process menu on the Menu toolbar and click on the 
Process Tree in the drop-down Process menu.

zz Right-click inside the Process Tree window and click 
on the Append New from the Right-click menu. The 
Edit Process dialog appears.

zz Type “Segmentation” (name of the Parent process, which serves as a wrapper for the underlying processes and 
can execute the whole sequence of underlying processes) in the Name field of the Edit Process dialog box and 
Click OK.

Inserting Child Process (Multi-resolution Segmentation Process)
zz Again in the Process Tree window, select the “Segmentation” Parent Process and right-click on it. Click on Insert 

Child from the context menu. The Edit Process dialog box appears.
zz In the Algorithm drop-down box of the Edit Process 

dialog box, select Multiresolution Segmentation 
from the lists. 

zz Keep the Pixel Level in the Image Object Domain 
drop-down menu box.

zz In the Algorithms Parametres for Segmentation, 
which now appear on the right-hand side of the 
dialog box, change the Level Name to Level 1 
(name of the image object level to be created), 
Image Layer Weights as 0 for Dem and Slope, 
and 1 for Band 1 to Band 7, Scale Parametre as 
10, and set Composition of Homogeneity as default. 
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zz Then press Execute to process the rule and save the rule in the Process Tree window. 

zz The New Image Layer will appear as Layer 1 in the Object Hierarchy drop-down menu of the View Navigation 
toolbar. 

Multi-resolution segmentation of Image at Scale factor 10 and image object level as “Level 1”

Creating New Arithmetic Features
The most crucial part in Definiens eCognition Developer software is finding 
the optimal features and values for classifying image objects in one of the 
classes. The “Feature View” is a tool that helps to find the Optimal Features 
and to determine Threshold Values for classification. With the “Feature View” 
the values for all objects are displayed in the viewer in Grey Values. There 
are also functions or options to create your one new feature from the arithmetic 
and relational calculation of the available features. To create New Arithmetic 
Features, use the following steps:
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zz If the Feature View window is not already open, go to the Tools menu in 
the menu bar and click on Feature View from the lists; alternatively, select 
the “Feature View” button  from the “Tool” toolbar. The Feature View 
window will appear.

zz In the Feature View window, expand the Object Features menu by 
clicking on the Plus sign of the Object Features menu and similarly expand 
the Customized menu.

zz Double click on the Create New “Arithmetic Features”. The Edit 
Customized Features window will appear.

zz Assign the feature name as NDSI in the Feature Name textbox of the Edit 
Customized Feature window.

zz Assign the arithmetic expression “([Mean Band 2] - [Mean 
Band 5])/ ([Mean Band 2] + [Mean Band 5])” in the Feature 
Calculator text box. To assign an arithmetic expression, use 
the calculator and select features “[Mean Band 2]” from the 
Feature Tree on the right side of the calculator.

zz Click the OK button to confirm the process. The newly created 
Features will appear in the Customized sub-menu of the Object 
Features in the Feature Tree menu in the Feature View window.

zz Similarly, assign the following features, which are useful for 
glacier mapping:

S.N. Feature name Arithmetic expression

1 NDVI ([Mean Band 4] - [Mean Band 3])/ ([Mean Band 4] + [Mean Band 3])
2 LWM ([Mean Band 5])/ ([Mean Band 2] + 0.0001) *100
3 NDWI ([Mean Band 4] - [Mean Band 5])/ ([Mean Band 4] + [Mean Band 5])
4 Band35 ([Mean Band 3] - [Mean Band 5])/ ([Mean Band 3] + [Mean Band 5])
5 Band7/5 ([Mean Band 7])/ ([Mean Band 5] + 0.0001) *100

Create New Hue and Intensity Layers
zz In the Feature View window, expand the Object Features menu by clicking on the Plus sign of the Object 

Features menu and similarly expand the Layer Values and Hue, 
Saturation, Intensity menu.

zz Double click on the Create New “HIS Transformation”. The Create HSI 
Transformation window will appear.

zz Assign the Value of the Layer “Red” Parametre as “Band 3” from the 
drop-down list. Follow the same procedure for Layer “Green” as “Band 
2” and Layer “Blue” as “Band 1”.

zz Select Hue (color) from the drop-down list as Output and then click on 
the OK button to create the Hue Layer.

zz Now you can see the Hue layer added in the menu under the “Hue, 
Saturation, Intensity” tree menu.

zz Create the Intensity layer in the same manner.
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Modify the Image Object Level (“Level 1”)
To make the classification of the image simpler and easier, the image object level is modified using the Spectral 
Difference Segmentation process, which merges the neighboring objects according to their mean layer intensity 
values. To modify the image objects level using Spectral Difference Segmentation, take the following steps:

zz Select and right-click on the “Segmentation” 
parent process that is already created 
during segmentation. Click on the Insert 
Child from the context menu. The Edit 
Process dialog box appears.

zz In the Algorithm drop-down box of the 
Edit Process dialog box, select Spectral 
Difference Segmentation from the lists. 

zz Select the Image Object Level in the Image 
Object Domain drop-down menu box.

zz Select Level as “Level 1” to be modified. 
zz Click on ‘…’ next to the Threshold 

Condition field and the Select Single 
Feature dialog box will open.

zz Browse to “Object features > Customized 
> NDSI” and double-click on it. The Edit 
Threshold Condition dialog box opens.

zz Choose Greater than or Equal to as operator from 
the Threshold settings in the dialog box and enter 
the value 0.64 in the text box.

zz Click on OK to confirm.
zz In the Algorithms Parametres for Segmentation, 

which now appear on the right-hand side of the 
dialog box, select the Level Usage as “Create 
Above” and change the Level Name to “Level 2” 
(name of the image object level to be created), 
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Image Layer Weights as 0 for Dem and Slope; and 1 for Band 1 to Band 7 and Maximum Spectral Difference 
as 150. 

zz Then Press Execute to process the rule and save the rule in the Process Tree window. This modifiy the image 
object of Clean-ice glacier parts by merging smaller objects to the larger image objects

zz Again, modify the Image object level “Level 2” by applying the same steps using threshold Condition as NDVI >= 
-0.01 and a Maximum Spectral Difference of 100 and save the image object level as “Level 3”. This modifies 
the non-glacier objects.

zz Also, modify the Image object level “Level 3“ by applying the same steps using threshold Condition as Mean 
Slope <= 14 and Maximum Spectral Difference of 15 and save the image object level as “Level 4”. This 
modifies the Debris-covered glaciers into bigger objects.

Image Object Level – ”Level 2”: Modifying objects level 1 using Spectral Difference Segmentation with threshold 
setting NDSI >= 0.64 and spectral difference 150
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Image Object Level – ”Level 3’”: Modifying objects level 2 using Spectral Difference Segmentation with 
threshold setting NDVI >= -0.01 and spectral difference 100

Image Object Level – “Level 4”: Modifying objects level 3 using Spectral Difference Segmentation with threshold 
setting Mean Slope <= 14 and spectral difference 15
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Create a Class in the “Class Hierarchy” window
zz If the Class Hierarchy window is not already open, go to the Classification 

menu in the Menu bar and click on the Class Hierarchy from the lists; 
alternatively, select the “Class Hierarchy”  button from the “Tool” toolbar. 
The Feature View window appears.

zz Right-click in the “Class Hierarchy” window and select “Insert Class” from the 
context menu. The “Class Description” dialog box opens.

zz Enter “Clean-ice” in the “Name” field. Keep the default color or change the 
color from the color drop-down box.

zz Click on OK to confirm.

zz Again, follow the same process to create “Debris-covered” class.

Classify the Glacier (Clean-ice)

Inserting Parent Process
zz If the Process Tree window is not opened, go to the Process menu in the Menu 

bar and click on the Process Tree  in the drop-down 
Process menu; alternatively, select the Process Tree button  from the Tool 
toolbar. The Process Tree window will open.

zz Right-click inside the Process Tree window and click on Append New from the 
context menu. The Edit Process dialog appears.

zz Type “Classification” (name of the Parent Process which 
serves as a wrapper for the underlying processes 
and can execute the whole sequence of underlying 
processes) in the Name field of the Edit Process dialog 
box and Click OK.

zz Now select Classification in the Process Tree window 
and right-click on it. Select Insert Child from the context 
menu. The Edit Process dialog box appears.

zz Assign “Clean-ice” (as sub-parent process) in the Name 
field and Click OK to confirm.

Inserting Child Process (Rules for Classification of 
Clean-ice)

zz Select the “Clean-ice” sub-Parent Process and right-
click on it. Click on Insert Child from the context 
menu. The Edit Process dialog box appears.

zz In the Algorithm drop-down box of the Edit Process 
dialog box, select assign class from the lists. 

zz Select the Image Object Level in the Image Object 
Domain drop-down menu box.

zz Select Level as “Level 4” to set as the level domain.
zz In the Class Filter field keep none.
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zz Click on ‘…’ next to the Threshold 
Condition field and the Select Single 
Feature dialog box will open.

zz Browse to “Object features > 
Customized > NDSI” and double-
click on it. The Edit threshold 
condition dialog box opens. 

zz Choose greater than as operator 
from the Threshold settings in the 
dialog box and enter the value 0.25 
in the text box.

zz Click on OK to confirm.
zz In the Algorithms Parametres section 

in the right pane, select Clean-ice from the drop-
down list in the Use Class field to define the target 
class.

zz Then confirm the process setting with the OK button.
zz Right-click on the saved process and click on 

Execute from the context menu. The classified 
image objects level is seen in the Map window. 

Removing Misclassified Image Objects from the 
Clean-ice Glacier

zz Select the “Clean-ice” sub-Parent Process and 
right-click on it. Click on Insert Child from the 
context menu. The Edit Process dialog box 
appears.

zz In the Algorithm drop-down box of the Edit 
Process dialog box, select assign class from the 
lists. 

zz Select the Image Object Level in the Image 
Object Domain drop-down menu box.
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zz Select Level as “Level 4” to set as the level domain.
zz In the field Class Filter, select the Clean-ice class from drop-down list.
zz Click on ‘…’ next to the Threshold Condition field and the Select Single Feature dialog box will open.
zz Browse to “Object features > Layer Values > Mean > Slope” and double-click on it. The Edit threshold condition 

dialog box opens.
zz Choose greater than as operator from the Threshold settings in the dialog box and enter the value 50 in the text 

box.
zz Click on OK to confirm.
zz In the Algorithms Parametres section in the right pane, select unclassified from the drop-down list of the Use 

Class field to define the target class.
zz Then confirm the process setting with the OK button.
zz Select the rule in the Process Tree window. Arrange it by dragging and placing it one step down from the 

previously created rules.
zz Right-click on the rule set and click on Execute from the context menu.
zz Repeat the same process, defining Threshold Setting as NDVI <= -0.3 and LWM > 32.25, to remove other 

misclassified objects from the Clean-ice class.

Note: To refine the classification of the Clean-ice glacier, you can also use other parametres or features 
such as DVI, RVI, NDWI, DEM, Hue, Brightness, Mean Bands, etc.

Merging Classified Clean-ice Objects.
zz Select the “Clean Ice” sub-Parent Process and 

right-click on it. Click on Insert Child from the 
context menu. The Edit Process dialog box 
appears.

zz In the Algorithm drop-down box of the Edit 
Process dialog box, select Merge Region 
from the lists. 

zz Select the Image Object Level in the Image 
Object Domain drop-down menu box.

zz Select Level as “Level 4” to set as the level 
domain.

zz In the field Class Filter, select the Clean Ice 
class from the drop-down list.

zz In the Algorithms Parametres section in the 
right pane, select Yes from the drop-down list 
of Fusion Super Objects field and set it as the default on the Use Thematic Layers field.

zz Then confirm the process setting with OK button
zz Select the rule in the Process Tree window. Arrange it by dragging and placing it one step down from the 

previously created rules.
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zz Right-click on the rule set and click on Execute from the context menu. Then the classified object Clean-ice is 
merged and viewed in the Map window.

Removing Misclassified Smaller Image Objects by Using Area Class from the Clean-ice Glacier
zz Select the “Clean-ice” sub-Parent Process and right-click on it. Click on Insert Child from the context menu. The 

Edit Process dialog box appears.
zz In the Algorithm drop-down box of the Edit Process dialog box, select assign class from the lists. 
zz Select the Image Object Level in the Image Object Domain drop-down menu box.
zz Select Level as “Level 4” to set as the level domain.
zz In the field Class Filter, select the Clean-ice class from the drop-down list.
zz Click on ‘…’ next to the Threshold Condition field and the Select Single Feature dialog box will open.
zz Browse to “Object features > Geometry > Extent > Area” and right-click on the “Area”, then select “Edit unit” 

from the list.
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zz Choose “Square Kilometres” from the drop-down menu list of “Feature unit” in the 
Select Unit window and close the window.

zz Double-click on “Area” in the list “Object features > Geometry > Extent >”. The 
Edit threshold condition window will open.

zz Choose less than as operator from the Threshold settings in the window and enter the value 0.04 in the text box.
zz Click on OK to confirm.
zz In the Algorithms Parametres section in the right pane, select Unclassified from the drop-down list of the Use 

Class field to define the target class.
zz Then confirm the process setting with the OK” button.
zz Select the rule in the Process Tree window. Arrange it by dragging and placing it one step down from the 

previously created rules.

After completion of the process, do not forget to save the project.
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7.3	 Hands-on Exercise III: Debris-covered Glacier Mapping 

Classify the Glacier (Debris-covererd)

Inserting Parent Process for Debris-covered
zz Select Classification parent process in the Process Tree 

window and right-click on it. Select Insert Child from the 
context menu. The Edit Process dialog box appears.

zz Assign “Debris-covered” (as sub-parent process) in the 
Name field and Click OK to confirm.

Inserting Child Process (Rules for Classification of Debris Cover)
zz Select the “Debris-covered” sub-Parent Process 

and right-click on it. Click on Insert Child from the 
context menu. The Edit Process dialog box appears.

zz In the Algorithm drop-down box of the Edit Process 
dialog box, select assign class from the lists. 

zz Select the Image Object Level in the Image Object 
Domain drop-down menu box.

zz Select Level as “Level 4” to set as the level domain.
zz In the Class Filter field, select the unclassified class 

from drop-down list.
zz Click on ‘…’ next to the Threshold Condition field 

and the Select Single Feature dialog box will open.

zz Browse to “Object features > Layer Values > Mean > Slope” and double-click on it. The Edit threshold condition 
dialog box opens.

zz Choose less-than or equal-to as operator from the Threshold settings in the dialog box and enter the value 30 in 
the text box.

zz Click on OK to confirm.
zz In the Algorithms Parametres section in the right pane, select Debris-covered from the drop-down list of the Use 

Class field to define the target class.
zz Then confirm the process setting with the OK button
zz Right-click on the saved process and click on Execute from the context menu. The classified image objects level is 

seen in the Map window. 
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Removing Misclassified Image Objects from the Debris-covered Glacier
zz Select the ‘Debris-covered’ sub Parent Process and 

right-click on it. Click on Insert Child from the context 
menu. The Edit Process dialog box appears.

zz In the Algorithm drop-down box of the Edit Process 
dialog box, select assign class from the lists. 

zz Select the Image Object Level in the Image Object 
Domain drop-down menu box.

zz Select Level as “Level 4” to set as the level domain.
zz In the field Class Filter, select the Debris-covered class 

from the drop-down list.
zz Click on ‘…’ next to the Threshold Condition field and 

the Select Single Feature dialog box opens.
zz Browse to “Object features > Customized > NDVI’” 

and double-click on it. The Edit threshold condition dialog box opens.
zz Choose greater than or equal to as operator from the Threshold settings in the dialog box and enter the value 

-0.01 in the text box.

zz Click on OK to confirm.
zz In the Algorithms Parametres section in the 

right pane, select Unclassified from the drop-down list of the Use Class field to define the target class.
zz Then confirm the process setting with the OK” button.
zz Select the rule in the Process Tree window. Arrange it by dragging and placing it one step down from the 

previously created rules.
zz Right-click on the rule set and 

click on Execute from the 
context menu.

zz Repeat the same process, 
defining the Threshold Setting 
as Band35 <= -0.3, Mean 
Dem <= 4100, Mean Band 
7 >= 100.5, Band7/5 <= 63 
sequentially to remove other 
misclassified objects from the 
Debris-covered class.

Note: To refine the classification of the Debris-covered glacier, you can also use other parametres or 
features such as DVI, RVI, Hue, Brightness, other Mean Bands, etc.
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Merging Classified Debris-covered Objects
zz Select the “Debris-covered” sub-Parent Process and right-click on it. Click on Insert Child from the context menu. 

The Edit Process dialog box appears.
zz In the Algorithm drop-down box of the Edit Process dialog box, select Merge Region from the lists. 
zz Select the Image Object Level in the Image Object Domain drop-down menu box.
zz Select Level as “Level 4” to set as the level domain.
zz In the Class Filter field, select the Debris-covered class from the drop-down list.
zz In the Algorithms Parametres section in the right pane, select Yes from the drop-down list of the Fusion super 

objects field and set it as the default in the Use Thematic Layers field.
zz Then confirm the process setting with the “OK” button

zz Select the rule in the Process Tree window. Arrange it by dragging and placing it one step down from the 
previously created rules.

zz Right-click on the rule set and click on Execute from the context menu. Then the classified objects Clean Ice is 
merged and viewed in the Map window.

In the same way set the following steps and run the process.

Removing Misclassified Image Objects by using Area Class from the Debris-covered Glacier
zz Select the “Debris-covered” sub-Parent Process and right-click on it. Click on Insert Child from the context menu. 

The Edit Process dialog box appears.
zz In the Algorithm drop-down box of the Edit Process dialog box, select assign class from the lists. 
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zz Select the Image Object Level in the Image Object Domain drop-down menu box.
zz Select Level as “Level 4” to set as the level domain.
zz In the Class Filter field, select Debris-covered class from the drop-down list.
zz Click on ‘…’ next to the Threshold Condition field and the Select Single Feature dialog box will open.
zz Browse to “Object features > Geometry > Extent > Area” and right-click on the “Area”. Then change the unit of 

the Area if it is different from the “Square Kilometres” by right-clicking on it and selecting “Edit unit” from the list.
zz Double click on “Area” in the list “Object features > 

Geometry > Extent >”. The Edit threshold condition 
window opens.

zz Choose less than as operator from the Threshold settings 
in the window and enter the value 1 in the text box.

zz Click on OK to confirm.
zz In the Algorithms Parametres section 

in the right pane, select Unclassified 
from the drop-down list of the Use 
Class field to define the target class.

zz Then confirm the process setting with 
OK button

zz Select the rule in the Process Tree 
window. Arrange it by dragging 
and placing it one step down from 
the previously created rules and click 
on Execute.

After completion of the process, do not forget to save the project.
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7.4 	 Complete the Rule Sets of this Exercise
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7.5 	 Manual Editing of Objects

Manual editing of image objects and thematic objects allows you to manually influence the result of an image 
analysis. The main manual editing tools are Merge Objects Manually, Classify Image Objects Manually, and Cut an 
Object Manually.

While manual editing is not commonly used in automated image analysis, it can be applied to highlight or reclassify 
certain objects or to quickly improve the analysis result without adjusting the applied rule set. 

To open the Manual Editing toolbar, choose View > Toolbars > Manual Editing on the Main menu; alternatively, 
click on the Manual Editing Toolbar button  in the Tools toolbar. The Manual Editing Toolbar appears.

Change Editing Mode
The Change Editing Mode drop-down list on the Manual Editing toolbar is set to 
Image Object Editing by default. If you work with thematic layers and want to edit 
them by hand, choose Thematic editing from the drop-down list.

Selection Tools
Objects to be fused or classified can be selected from the Manual Editing toolbar in one 
of the following ways:

1.	 Single Selection Mode selects one object. Select the object with a single click.

2.	 Polygon Selection selects all objects that lie within or touch the border of a polygon. Set vertices of the polygon 
with a single click. Right-click and choose Close Polygon to close the polygon.

3.	 Line Selection selects all objects along a line. Set vertices of the line with a single click. A line can also be closed 
to form a polygon by right-clicking and choosing Close Polygon. All objects that touch the line are selected.

4.	 Rectangle Selection selects all objects within or touching the border of a rectangle. Drag a rectangle to select the 
image objects.

Merge Objects Manually
The manual editing tool Merge Objects is used to manually merge selected neighboring images or thematic objects.

Note: Manual object merging operates only on the 
current image object level.

Choose Tools > Manual Editing > Merge Objects from the 
main menu bar or press the Merge Objects Manually button on 
the Manual Editing toolbar to activate the input mode. Or you 
can use right-click.

1 2 3 4
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Note: You should have at least two objects.

Classify Image Objects Manually
The manual editing tool Classify Image Objects allows easy class assignment of selected image objects.

Manual image object classification can be used for the following purposes:

zz Manual correction of previous classification results, including classification of previously unclassified objects.
zz Classification without rule sets (in case the creation of an appropriate rule set is more time-consuming), using the 

initial segmentation run for automated digitizing. Precondition: To classify image objects manually, the project has 
to contain at least one image object level and one class in the Class Hierarchy. 

To perform a manual classification, do one of the following:

zz Choose Tools > Manual Editing > Classify Image Objects from the menu bar or click 
on the Classify Image Objects  button in the Manual Editing Toolbar. 

zz Click the Classify Image Objects button on the Manual Editing toolbar to activate the 
manual classification input mode. 

zz In the Select Class for Manual Classification drop-down list box, select the class to which you want to manually 
assign objects. Note that selecting a class in the Legend window or in the Class Hierarchy window (if available) 
will not determine the class for manual editing; the class has to be selected from the before-mentioned drop-down 
list.

Now objects can be classified manually with a single mouse-click. To classify objects, do one of the following:

zz Select the Classify Image Objects button and the Class for Manual Classification. Click the image objects to be 
classified.

zz Select the image object(s) you want to classify first. Select the Class for Manual Classification and press the 
Classify Image Objects button to classify all selected objects.

zz Select one or more image objects, right-click into the image object(s), and select Classify Selection from the 
context menu. 

When the object is classified, it is painted in the color of the respective class. 

If no class is selected, a mouse-click deletes the previous class assignment; the image object becomes unclassified. 

To undo a manual classification on a previously unclassified object, simply click the object a second time. If the 
object was previously classified, then clicking again does not restore the former classification; instead, the object 
becomes unclassified.
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8.	Online Resources for Glacier Database

ICIMOD 
The International Centre for Integrated Mountain Development (www.icimod.org) attaches great importance to 
the Himalayan glaciers for climate change research and ecosystem services and has been involved in building 
a long-term database on Himalayan glaciers since the late 1990s. The database is being disseminated through 
“Mountain Portal”, an interactive web service through the Google Earth (GE) interface. Also part of the information 
are additional parametres, such as 

zz Physical condition - Orientation, drainage condition; 
zz Type – moraine dam, supra glacier, erosion, block, cirque, valley; 
zz Spatial - latitude, longitude, area, length, elevation values; 
zz Estimated - ice thickness, ice reserve; 
zz Orientation - accumulation, ablation; 
zz Classification - 6 digit WGMS standard. 

The data layers are divided into the 19 sub-basins of Nepal. However, data (glaciers polygon dataset) layers 
presented in this GE are generalized to the actual database to reduce the size of the KML. (http://geoportal.icimod.
org/)

NSIDC
The National Snow and Ice Data Center offers more than 500 data products to researchers, commercial 
applications users, and others worldwide. Their data are disseminated through the NSIDC Distributed Active Archive 
Center (DAAC). (http://nsidc.org/)

GLIMS
The Global Land and Ice Measurement System (http://www.glims.org/) project is currently creating a unique 
glacier inventory, storing information about the extent and rates of change of the entire world’s glacial resources. 
The GLIMS Glacier Database provides students, educators, scientists, and the public with reliable glacier data from 
research. Through the GLIMS Glacier Viewer Web Mapping Service (WMS), one can gain access to the GLIMS 
Glacier Database. This WMS allows users to view and query several thematic layers, including glacier outlines, 
ASTER footprints, Regional Center locations, and the World Glacier Inventory. Query results can be downloaded 
into a number of GIS-compatible formats, including ESRI Shape files, MapInfo tables, and Geographic Mark-up 
Language (GML). (http://glims.colorado.edu/cgi-bin/mapserv)

Randolph Glacier Inventory (RGI)
The Randolph Glacier Inventory (RGI) is a globally complete inventory of glacier outlines. It is supplemental to 
the Global Land Ice Measurements from Space initiative (GLIMS). Production of the RGI was motivated by the 
preparation of the Fifth Assessment Report of the Intergovernmental Panel on Climate Change (IPCC AR5). The RGI 
was released initially during 2012 with little documentation in view of the IPCC’s tight deadlines. In due course, the 
content of the RGI will be merged into the database of GLIMS. The RGI will, however, evolve into a downloadable 
subset of the extensive and diverse holdings of GLIMS, offering complete one-time coverage, version control, and a 
standard set of attributes. (http://www.glims.org/RGI/)

WGMS
Since 1986, the World Glacier Monitoring Service has maintained and continued the collection of information 
about ongoing glacier changes to support climate change research. Today, the WGMS collects standardized 
observations on changes in mass, volume, area, and length of glaciers with time (glacier fluctuations), as well as 
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statistical information on the distribution of perennial surface ice in space (glacier inventories). Such glacier fluctuation 
and inventory data are high priority key variables in climate system monitoring; they form a basis for hydrological 
modelling with respect to possible effects of atmospheric warming, and provide fundamental information in 
glaciology, glacial geomorphology, and quaternary geology. The highest information density is found for the Alps 
and Scandinavia, where long and uninterrupted records are available. (http://www.geo.unizh.ch/wgms/)

GlobGlacier
The GlobGlacier supported by the European Space Agency (ESA) is yet another initiative that complements and 
strengthens the existing network for global glacier monitoring. The project will help to establish a global picture 
of glaciers and ice caps, and their role as Essential Climate Variables (ECVs). In this respect, the most requested 
issue is to complete the world glacier inventory (WGI) from the 1970s by producing glacier outlines in regions and 
to complement the point information already stored in the WGI by 2D information to allow change assessment. 
Moreover, GlobGlacier will integrate satellite data from various sensors to create value-added products for a wide 
range of user communities. A close cooperation with major user groups (e.g., WGMS) and related projects (e.g., 
GLIMS) will ensure the maximum benefit of the generated products from a global perspective. (http://globglacier.
ch/)

WDC 
The World Data Center for Glaciology and Geocryology, Lanzhou is a part of the World Data Center and is 
committed to the collection, saving, management, and analysis of the Chinese Cryosphere Database, which includes 
the Polar Regions and high Asia Regions. The collection of the glacier data is intended to contribute to the research 
on global climate change. (http://wdcdgg.westgis.ac.cn/)

GSI 
The Geologic Survey of India has conducted advance studies like glacier mass balance and flow hydrometry of the 
Indian Himalayan glacier since 1978. (http://www.portal.gsi.gov.in)

For glacier data analysis, please use the companion manual: Training Manual on Application of Remote Sensing 
and Geographic Information Systems or Mapping and Monitoring of Glaciers, Part 2 (ICIMOD Manual 2017/11)
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